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Introduction

This chapter includes information on the precautions to be read before using 
EOS DIGITAL Software, how to use this Instruction Manual, the system 
requirements and the supported image types. It also explains the software 
configuration.

Click on the item to display its page.
Main Features ..................................................................................................................... 0-2
System Requirements........................................................................................................ 0-2
Supported Images .............................................................................................................. 0-2
Software Configuration...................................................................................................... 0-3

About This Manual
Thank you for purchasing this Canon product.
Precautions for using this product safely and icons to help you with procedures, etc. are 
described at the beginning of this Instruction Manual. Please be sure to read these first before 
proceeding to the information in the other chapters.

It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual 
without permission.
Canon may change without notice the software specifications and contents of this 
Instruction Manual.
The software screens and displays printed in this Instruction Manual may differ slightly 
from the actual software.
The content of this Instruction Manual has been reviewed thoroughly. However, if you 
should notice any errors or omissions, please contact a Canon Service Center.
Please note that irrespective of the above-mentioned, Canon does not take responsibility 
for the outcome of the operation of the software.

Please read the safety precautions carefully before using this product. Ensure that you use the 
product correctly according to the procedures described in these instructions.
The following safety precautions are intended to instruct you in the safe and correct operation 
of the product and its accessories to prevent injuries or damage to yourself, other persons and 
property. Please read and ensure that you understand them before you proceed to the other 
sections of these instructions.

Canon and EOS are trademarks of Canon Inc.
IBM is a registered trademark of International Business Machines Corporation.
Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in 
the United States and/or other countries.
Other names and products not mentioned above may be registered trademarks or 
trademarks of their respective companies.

 Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The 
extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player) 
could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to 
the loud sounds of a data CD-ROM played on a music CD player.

Safety Precautions

Trademark Acknowledgments

In this manual, Windows XP Professional/Home Edition is referred to as “Windows XP”, Windows 
Millennium Edition is referred to as “Windows Me”, Windows 2000 Professional is referred to as 
“Windows 2000”, and Windows 98 Second Edition is referred to as “Windows 98SE”.
In this manual, the screens used in the examples are from Windows XP.
This manual describes operating methods for the EOS-1D Mark II N or EOS 5D and uses 
the EOS-1D Mark II N or EOS 5D screens in examples. Supplementary information has 
been given where necessary about functions that are unique to each camera.
The camera name is shown in the screens as “EOS XXX”.
In this document, square brackets [ ] are used to indicate items such as window names, 
menu names and button names that appear on the computer screen.
Text inside < > in this document indicates the keys on the keyboard and camera button 
names.
Asterisk in (p.*-*) in this document shows reference pages.
Descriptions of camera operations assume that the reader is familiar with the information in 
the camera’s Instruction Manual.
For the restrictions that apply to the software products, refer also to the Readme files for the 
respective products.

 in this document indicates the sequence of operation as shown on 
the right. 
Example: [View] menu  [Show Information]  [File Name]

The explanations given below describe the type of content indicated by the respective icons.
 : Marks information that should be read before use to prevent problems that would 

interfere with the functioning of software and computer.
 : Marks additional information that you will find helpful.

Click any of the chapter content buttons at the right of the Instruction Manual to display the 
front page of each chapter.
Clicking the buttons on the bottom right of the Instruction Manual allows you to move as follows:

 : Displays the previous page.

 : Displays the next page.

 : Returns to the previously displayed page.

Instruction Manual Notice
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Main Features
EOS DIGITAL Solution Disk contains software with the following features and functions for 
exclusive use with Canon digital cameras.

ZoomBrowser EX is software for viewing and editing images and is designed for a wide 
range of users who mainly shoot JPEG images.
Together with each software, you can perform standard workflow (procedure) of 
downloading, viewing, editing and printing images.
You can display and view 3 types of image lists, display an individual image in enlarged 
view, display comparisons of multiple images, or display images as a slide show.
You can classify images by the date on which they were shot, rename multiple files in a 
single operation, and select and organize images by setting “Rating” or “Keyword”.
You can search for images using various types of information such as the date on which 
they were shot or by the “Rating” you have set.
Various types of image editing are available, including JPEG image editing functions, image 
rotation, RAW image editing using RAW Image Task, and JPEG image merging using 
PhotoStitch.
Together with EOS Capture, you can shoot photos remotely.
With the image transfer function, you can perform image editing using third-party image 
editing software.
You can perform various types of printing to suit your needs such as one-page printing, 
printing an index of your images, or laying out and printing images using PhotoRecord.
You can export images for various purposes such as converting and saving JPEG images, 
exporting for use as a screen saver or wallpaper, or writing to a CD-R/CD-RW.
You can attach an image to an e-mail and send it.
You can connect to CANON iMAGE GATEWAY and receive various online services.
ZoomBrowser EX is compatible with Color Management System.
ZoomBrowser EX is compatible with 2 types of color space (sRGB, Adobe RGB).

Together with ZoomBrowser EX, you can download to your computer images saved on the 
memory card inside your camera and perform various settings for your camera.
You can download in a single operation multiple images saved on the memory card inside 
your camera, display a list of images, and download only selected images.
CameraWindow is also compatible with image download using a third-party card reader.
With the EOS-1D Mark II N and EOS 5D, you can set in the camera a Picture Style file 
saved on your computer. Also, with the EOS-1D series cameras, you can register Personal 
Functions and various shot settings in the camera.
Together with EOS Capture, you can shoot photos remotely.

Together with ZoomBrowser EX, you can process and display RAW images, and set and 
change processing parameters.
With the high image quality processing and the camera-faithful algorithm of Canon’s 
genuine software, you can process RAW images in the same colors as the camera.
You can set the same processing parameters as the camera or change the conditions. Also, 
there is hardly any image deterioration after changing the processing parameters.
You can convert or save a RAW image as a TIFF or JPEG image, and attach an ICC profile.
RAW Image Task is compatible with Color Management System.
RAW Image Task is compatible with 2 types of color space (sRGB, Adobe RGB).

ZoomBrowser EX (Image Viewing and Editing Software)

CameraWindow (Software for Communication with the Camera)

RAW Image Task (RAW Image Processing Software)

Together with CameraWindow and ZoomBrowser EX, you can shoot photos remotely where 
the camera is controlled from your computer.
You can shoot and set various settings by controlling the camera from your computer.
EOS Capture can also be used for shooting with the camera’s shutter button. 

Together with ZoomBrowser EX, you can lay out and print images freely.
You can adjust the placement and size of images, select frames, add text, etc. and print.

Together with ZoomBrowser EX, you can create panorama images, etc. by merging multiple 
JPEG images.

This software supports the following image types.

OS Windows XP (Professional/Home Edition), Windows Me, 
Windows 2000, Windows 98SE

Computer
Computer with one of the above OS preinstalled and a USB port as a 
standard feature or an OHCI-compliant IEEE1394 port.
* Upgraded machines not supported.

CPU 500MHz Pentium or higher

RAM Windows XP, Windows 2000 Minimum 256MB
Windows Me, Windows 98SE Minimum 128MB

Interface USB 1.1 to 2.0 Hi-Speed, IEEE1394

Hard disk space

ZoomBrowser EX, CameraWindow, PhotoRecord, 
RAW Image Task 250MB or more

EOS Capture 300MB or more
PhotoStitch 40MB or more
PTP WIA Driver/PTP TWAIN Driver
WIA Driver/TWAIN Driver 50MB or more

Display Screen resolution: 1024 × 768 pixels or more 
Color quality: Medium (16 bit) or more

Image type/ Camera used Extension
JPEG images Exif 2.2 or 2.21-compatible JPEG or JFIF images .JPG, .JPEG

RAW images

EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II, 
EOS 5D, EOS 350D DIGITAL or EOS 20D .CR2

EOS-1Ds, EOS-1D .TIF
EOS 300D DIGITAL, EOS 10D, EOS D60 or EOS D30 .CRW

BMP images Bitmap images .BMP
TIFF images Exif-compatible TIFF images .TIF, .TIFF
PCD images Kodak Photo CD images .PCD

EOS Capture (Remote Shooting Software)

PhotoRecord (Layout Printing Software)

PhotoStitch (Image Merging Software)

System Requirements

Supported Images
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Software Configuration
The software on the EOS DIGITAL Solution Disk operates together with the software shown below, centering on ZoomBrowser EX.

: Shows the shot image flow.
: Shows the camera control information from the software.

Download image

Download image

CameraWindow (Software for Communication with the Camera)

Various camera 
settings

Press the [Shoot] button

Various camera settings

Download image

Communicates with the camera to download 
to your computer images saved on the 
memory card inside your camera, and can 
transfer images to ZoomBrowser EX (p.1-4).
You can download multiple images in a 
single operation, display images as a list, 
and download only selected images 
(p.1-4).
Images from your card reader can also be 
downloaded (p.1-5).

You can set the camera owner’s name and the date and time (p.1-5, p.4-2).
With the EOS-1D Mark II N and EOS 5D, you can set the Picture Style and set 
the Picture Style file saved on your computer to the camera (p.4-11). Also, with 
the EOS-1D series cameras, you can register Personal Functions and various 
shooting settings in the camera (p.4-3, p.4-12 to p.4-15).
Together with EOS Capture, you can shoot photos remotely (p.3-2).

You can display images as a list or 
display an image in enlarged view on 
a separate window (p.2-4 to p.2-7).
You can classify images by the date 
and time they were shot and organize 
images by setting “Rating” or 
“Keyword” (p.2-10).
You can search for images by setting 
conditions (p.2-10).

You can edit images (p.2-11).
You can convert and save a JPEG image into a separate image and 
export for use as wallpaper, etc (p.2-14 to p.2-16).
You can print one image or print an index of your images (p.2-16 to p.2-18).
You can attach an image to an e-mail message in your mail software or 
connect to CANON iMAGE GATEWAY (p.2-19).
Together with all the software, you can download images from your 
camera (p.1-4) and perform settings for your camera (p.1-5, p.4-2), lay 
out and print images (p.2-17), process RAW images (p.2-12), shoot 
photos remotely (p.3-2), and merge images (p.2-11).

ZoomBrowser EX (Image Viewing and Editing Software)

Lay out image and print

EOS Capture (Remote Shooting Software)

RAW Image Task (RAW Image Processing Software)
PhotoStitch (Image Merging Software)

Select RAW image and process
Select JPEG images and merge

Print image

PhotoRecord (Layout Printing Software)

Transfer 
image

Transfer image

Together with CameraWindow and ZoomBrowser 
EX, you can download images you have shot 
remotely to your computer (p.3-2).
You can also download the image you have shot by 
pressing the camera’s shutter button to your 
computer.
You can control the camera from your computer 
and perform various settings (p.3-3).

You can lay out and print images 
selected in ZoomBrowser EX 
(p.2-17).
You can adjust the placement and 
size of images, select frames, add 
text, etc. and print.

You can merge JPEG 
images selected in 
ZoomBrowser EX to create 
panorama images, etc 
(p.2-11).

You can process and display RAW images 
selected in ZoomBrowser EX and change 
processing parameters (p.2-12).
You can set the same processing parameters 
as the camera or change the conditions.
You can convert and save a RAW image as a 
TIFF or JPEG image.
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Downloading Images from the Camera, and Camera Settings

This chapter explains how to set up communication mode, how to connect 
the camera or a card reader (third-party product) to your computer, how to 
download images, and explains camera settings, etc. For EOS 5D and EOS-
1D series camera settings, refer to Chapter 4.

For more information on the restrictions of the CameraWindow, refer also to the 
source listed below.

Readme: Click the [Start] button  select [All Programs] ([Programs] in versions 
other than Windows XP)  [Canon Utilities]  [CameraWindow]  
[CameraWindow MC 5 Readme], and the [Readme] file in the folder with 
your camera name.

Click on the item to display its page.
Connecting the Camera to Your Computer ..................................................... 1-2

Downloading Images from Your Camera ......................................................... 1-4

Downloading All the Images in a Single Operation.......................................... 1-4

Downloading Selected Images ........................................................................ 1-4

Camera Settings ................................................................................................. 1-5

Downloading Images Using Your Card Reader............................................... 1-5

Downloading JPEG Images Using the PTP Function ..................................... 1-6

You can set the camera’s communication mode to [PC connect.], [PC connection] or [Normal].
The settings on this page are only necessary for the EOS 5D, EOS 350D DIGITAL, 
EOS 20D, EOS 300D DIGITAL and EOS 10D.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on 
changing, refer to the Canon web site.

About the PTP Setting
You can download JPEG images that use the PTP (Picture Transfer Protocol) function in 
Windows XP, when the camera’s communication mode is set to [Print/PTP] or [PTP] (p.1-6).

1 Check that the camera is not connected to the computer and then 
set the camera’s power switch to <ON>.

2 Set the camera’s communication mode to [PC connect.], [PC 
connection] or [Normal].

With the EOS 5D, set [  Communication] 
in menu to [PC connect.].
With the EOS 350D DIGITAL, set 
[Communication] in menu option [ ] to 
[PC connection].
With the EOS 20D and EOS 10D, set 
[Communication] in menu to [Normal].
With the EOS 300D DIGITAL, set 
[Communication] in menu option [ ] to 
[Normal].

3 Press the < > button to switch the LCD monitor display off 
and then set the camera’s power switch to <OFF>.

When setting the communication mode, always ensure that the camera is not 
connected to the computer beforehand. Setting the communication mode while the 
camera is connected to the computer will cause camera and software malfunctions.
When using the EOS 5D or EOS 350D DIGITAL, EOS Capture cannot be used if the 
camera’s communication mode is set to [Print/PTP].
When using the EOS 20D, EOS 300D DIGITAL or EOS 10D, the camera and the 
software in the Solution Disk cannot communicate if the camera’s communication 
mode is set to [PTP].

Setting the Communication Mode

Operation window in the EOS 5D
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Connecting the Camera to Your Computer
Connection Procedure for Cameras other 
than the EOS-1D Series Cameras
(EOS 5D and EOS 350D DIGITAL etc.)
Before downloading images to your computer or specifying the camera settings, you must 
connect the camera to your computer with the interface cable supplied with the camera. 
You can connect the camera while your computer is running.

1 Plug the dedicated cable into the computer.
Plug the cable into the USB port.
Refer to the computer User’s Manual for 
information on the terminal areas.

2 Plug the dedicated cable into your camera.
Face the < > mark on the plug to the 
front of the camera and connect the plug 
to the camera’s < > terminal.
With the EOS D60 and EOS D30, connect 
by aligning the < > mark on the plug with 
the < > mark on the < > terminal.

3 Set the camera’s power switch to <ON>.

[CameraWindow] appears, the camera is ready to communicate with your computer.
Proceed to “Downloading Images from Your Camera” (p.1-4) continuously.

If the dialog box on the right appears, select 
[Canon CameraWindow] and then click the 
[OK] button to display [CameraWindow].
If [CameraWindow] does not appear, click 
the [Start] button  select [All Programs] 
([Programs] in versions other than Windows 
XP)  [Canon Utilities]  [CameraWindow] 

 [CameraWindow].

Connection Procedure for EOS-1D Series Cameras
(EOS-1D Mark II N and EOS-1Ds Mark II etc.)
Before downloading images to your computer or specifying the camera settings, you must 
connect the camera to your computer with the dedicated IEEE1394 interface cable 
supplied with the camera. You can connect the camera while your computer is running.

1 Plug the dedicated cable into the computer.
Plug the cable into the IEEE1394 port.
Confirm that the shape of the plug and the 
shape of the IEEE1394 port match, and 
then connect correctly.
Refer to the computer User’s Manual for 
information on the terminal areas.
When using the dedicated cable supplied 
with the EOS-1Ds and EOS-1D, either 
plug (6-pin type) can be connected.

2 Plug the dedicated cable into your camera. 
For the EOS-1D Mark II N, attach the 
cable protector supplied with the camera, 
and then connect the dedicated cable 
following the steps below.
Make sure the < > mark on the plug is 
facing the top of the camera and then 
connect the plug to the camera’s 
< > terminal.

When using the dedicated cable supplied with the EOS-1Ds and EOS-1D, either plug 
(6-pin type) can be connected. Confirm that the shape of the plug and the shape of 
the camera’s < > terminal match, and then connect correctly. 

3 Set the camera’s power switch to 
<ON>.

4 Start CameraWindow.
Click the [Start] button and select [All Programs] ([Programs] in versions other than 
Windows XP)  [Canon Utilities]  [CameraWindow]  [CameraWindow].
[CameraWindow] appears, the camera is ready to communicate with your computer. 
Proceed to “Downloading Images from Your Camera” (p.1-4) continuously.
When the camera selection window appears, select the connected camera and then 
[CameraWindow] will be displayed.
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Never perform the following operations while the software installed from the Solution 
Disk is running after connecting the camera to the computer as a communications 
error may occur.
• Set the camera’s power switch to <OFF>.
• Open the CF card slot cover.
• Disconnect the dedicated cable, remove the battery, or remove the AC Adapter Kit 

(optional), DC Coupler or DC Coupler Kit.
• Disconnect the plug and the power cord of the AC Adapter Kit (optional), DC 

Coupler or DC Coupler Kit.
Before you perform the operations above, be sure to exit all the software.
You cannot communicate with the camera when you are displaying images through 
the camera’s LCD monitor. Always connect the camera and your computer after 
turning off the display in the LCD monitor.
While the camera and your computer are communicating, the camera’s LCD panel 
may blink.
Use only the dedicated cable.
With EOS-1D series cameras, if you connect the plug of the dedicated cable into the 
computer’s IEEE1394 port in the reverse direction, the camera or the computer may 
break down. Confirm that the shape of the plug and the shape of the IEEE1394 port 
match before connecting.
With EOS-1D series cameras, you cannot communicate with CameraWindow even if 
you connect the USB interface cable supplied with the camera.
Push the plug firmly all the way into the socket. Loose connections can cause faults 
or malfunctions.
Do not connect the camera to your computer via a hub. If you do so, the camera may 
not operate correctly.
If you connect multiple USB or IEEE1394 devices (excluding mouse and keyboard) to 
your computer, the camera may not operate correctly. Disconnect from your computer 
any USB devices and IEEE1394 connection devices other than the camera.
Operation of the Auto power off function will automatically switch the camera off, 
disabling to communicate with your computer. Set the Auto power off function to 
[OFF] in advance. (Refer to the camera’s Instruction Manual.)
Do not connect more than one camera to the same computer. The connections may 
not operate correctly.
The camera cannot communicate correctly with multiple softwares. Use one software 
to communicate with the camera.
When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull 
it out.
* If you are using the EOS D60 or EOS D30, pull the plug while pressing the PUSH 

button on it.
If you do not perform any operation while the camera and computer are connected, a 
confirmation message may appear on the computer screen asking whether you wish 
to continue communicating with the camera for some computer systems. If you do not 
perform any operation even after this message appears, the communication with the 
camera is terminated. To re-establish the communication, press the shutter button 
down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

Do not put your computer to sleep while it is connected to the camera. 
If your computer goes into the sleep mode, never disconnect the dedicated cable while 
your computer is still in the sleep mode. Always wake your computer up while it is 
connected to the camera. On some types of computer, disconnecting the dedicated 
cable while your computer is in sleep mode could prevent the computer from waking 
up correctly. Refer to the computer User’s Manual for more information on sleep mode.

When you connect the camera and your computer, it is recommended that you use 
the AC Adapter Kit (optional) for the EOS 5D, EOS 350D DIGITAL, EOS 20D, EOS  
300D DIGITAL, EOS 10D, the DC Coupler supplied with the camera for the EOS D60 
and EOS D30, and the DC Coupler Kit supplied with the camera for EOS-1D series 
cameras.
When connecting the EOS-1D series camera and a computer with a 4-pin type 
IEEE1394 port, use the EOS-1D series dedicated Canon interface cable (optional) 4-
pin/4-pin type for the EOS-1D Mark II N, EOS-1Ds Mark II and EOS-1D Mark II, and a 
4-pin/6-pin type for the EOS-1Ds and EOS-1D.
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Downloading Images from Your Camera
\

You can download to your computer all the images saved on a memory card in the camera, in a 
single operation. You can follow this same procedure when downloading images using a third-
party card reader (p.1-5).

You can display the images saved on a memory card in the camera, select the images you 
want and download them to your computer. You can follow this same procedure when 
downloading images using a third-party card reader (p.1-5).

Click the [Starts to download images] button.
The [Save File] dialog box appears and 
the images are downloaded to the 
computer.
The downloaded images are sorted in 
folders by shot date, and are saved in the 
[My Pictures] folder on the computer.
When all the images have been 
downloaded, the ZoomBrowser EX starts 
and the downloaded images are 
displayed. Continue with the procedures in 
Chapter 2.

In the preferences, only images downloaded for the first time are downloaded and saved 
in the [My Pictures] folder (you cannot download images previously downloaded). You 
can change the image download type or the save destination in the dialog box that 
appears when you click the [Preferences] button.

1 Click the [Lets you select and download images] button.
The images on the memory card are 
displayed.

Downloading All the Images in a Single Operation

You can set the save destination and image 
type for downloaded images.

Downloading Selected Images 2 Select the images to download.
Click the target image.
To select multiple images, hold down the <Ctrl> key and click the images.
To select sequential images, click the first image and then hold down the <Shift> key 
and then click the last image.

3 Click the [Download pictures] button.
The [Download Image] dialog box appears.

4 Specify the save destination and then click the [Start Download] 
button.

The [Save File] dialog box appears and the images are saved in the specified folder.
When all the images have been downloaded, the ZoomBrowser EX starts and the 
downloaded images are displayed. Continue with the procedures in Chapter 2.

[ ] is displayed on images previously downloaded to your computer.
[ ] is displayed on images shot with AEB.
With the EOS-1D series cameras, a [ ] is displayed on images with sound recorded.

Downloads the 
images to 
computer.

You can select images 
by condition.

You can select the size of the displayed image.

You can show/hide the image frame.

You can show/hide the image information area.

Starts the ZoomBrowser EX.
Deletes the image.

Displays basic shooting 
information.

Displays detailed 
shooting information.

Displays the histogram 
(brightness distribution). 
[Bright.] is the brightness 
display, and [RGB] is the 
RGB display.

You can select the folder of the 
image displayed in the window.

Displayed on RAW images.

Displayed on RAW+JPEG images. Displayed on images that are protected.
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Camera Settings
Cameras other than the EOS 5D and EOS-
1D Series Cameras
You can perform settings on the camera, such as setting the camera owner’s name and 
setting the date and time.

EOS 5D and EOS-1D series cameras
For EOS 5D and EOS-1D series camera settings, refer to Chapter 4.

1 Select the [Set to Camera] tab.
The [Set to Camera] tab sheet appears.

2 Click the [Confirms/changes 
camera settings] button.

The [Camera Settings] dialog box 
appears.

3 Specify desired settings.

4 Click the [OK] button.
The settings are applied to the camera.

Initializing a memory card deletes all the data and the data cannot be recovered. Check 
carefully before initializing.

You can enter up to 31 
characters.

You can enter a value or 
click the [ ]/[ ] buttons 
to set. Displays the camera’s 

battery status. When the AC 
Adapter Kit (optional) or the 
DC Coupler is connected, 
[ ] is displayed.

Initializes the memory card.

You can set the camera to 
the date and time of your 
computer.

Displays the information of 
the memory card in the 
camera.

Displays the Information 
relating to the camera.

Applies the settings to 
the camera and closes 
the dialog box.

Cancels all the 
settings and closes 
the dialog box.

Applies the settings to 
the camera.

Downloading Images Using Your Card Reader
You can also download images to the computer using a thid-party card reader.

1 Load the card into the card reader.
The dialog box in step 2 appears.
If the dialog box in step 2 does not appear, 
click the [Start] button  select [All 
Programs] ([Programs] in versions other 
than Windows XP)  [Canon Utilities]  
[CameraWindow]  [CameraWindow].

2 Select [View/Download Images using Canon CameraWindow] and 
then click the [OK] button.

[CameraWindow] appears and image 
downloading preparation is complete.

3 Download the images.
To continue, you can download images 
using the same procedure as in 
“Downloading Images from Your Camera” 
(p.1-4).

Depending on the card reader you are using, you may not be able to download images 
using the [CameraWindow].

For information on connecting the card reader to your computer, refer to the card 
reader User’s Manual.
For the functions displayed in the [Set to Memory Card] tab sheet of the 
[CameraWindow], click each button and refer to the contents of the dialog box 
displayed or the Help.
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Downloading JPEG Images Using the PTP Function
Cameras other than EOS-1D Series Cameras
(EOS 5D and EOS 350D DIGITAL etc.)
When using Windows XP, you can use the PTP (Picture Transfer Protocol) function. If you 
set the camera’s communication mode to [Print/PTP] or [PTP], you can download JPEG 
images saved on a memory card in the camera to your computer without having to start 
the software provided on the Solution Disk.

This function is compatible with the EOS 5D, EOS 350D DIGITAL, EOS 20D, 
EOS 300D DIGITAL and EOS 10D only.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details 
on changing, refer to the Canon web site.

1 Check that the camera and the computer are not connected and 
then set the camera’s power switch to <ON>.

2 Set the camera’s communication mode to [Print/PTP] or [PTP].
With the EOS 5D, set [  Communication] 
in menu to [Print/PTP].
With the EOS 350D DIGITAL, set 
[Communication] in menu option [ ] to 
[Print/PTP].
With the EOS 20D and EOS 10D, set 
[Communication] in menu to [PTP].
With the EOS 300D DIGITAL, set 
[Communication] in menu option [ ] to 
[PTP].

3 Press the < > button to switch the LCD monitor display off 
and then set the camera’s power switch to <OFF>.

4 Connect the camera to the computer and set the camera’s power 
switch to <ON> (p.1-2).

The window for selecting the software to use for downloading the images is 
displayed.

5 Select [Microsoft Scanner and Camera Wizard] and click the [OK] 
button.

The [Scanner and Camera Wizard] dialog box appears.

6 Download images as directed in the [Scanner and Camera Wizard] 
dialog box.

EOS-1D Series Cameras
(EOS-1D Mark II N and EOS-1Ds Mark II etc.)
If you are using Windows XP, you can connect the USB interface cable supplied with the 
camera to the camera’s direct print terminal and download to your computer JPEG images 
saved on the memory card inside your camera using the PTP (Picture Transfer Protocol) 
function, without having to start the software provided on the Solution Disk.

If you want to use the PTP function, connect with the USB interface cable supplied with 
the camera.
This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D 
Mark II only.

1 Plug the dedicated cable into the computer.
Plug the cable into the USB port.
Refer to the computer User’s Manual for 
information on the terminal areas.

2 Plug the dedicated cable into your camera.
Face the plug’s < > mark towards the 
bottom of the camera and then connect 
the plug to the camera’s direct print 
terminal.

3 Set the camera’s power switch to <ON>.
The window for selecting the software to use for downloading the images is 
displayed.

4 Select [Microsoft Scanner and Camera Wizard] and click the [OK] 
button.

The [Scanner and Camera Wizard] dialog box appears.

5 Download images as directed in the [Scanner and Camera Wizard] 
dialog box.
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Due to Windows XP specifications, you may experience the following restrictions with 
the PTP function. We recommend downloading shot images using CameraWindow 
(p.1-4).
• RAW images cannot be downloaded. 

(Even if RAW images are displayed, they cannot be downloaded.)
• When a memory card in the camera contains both RAW images and JPEG images, 

you may not be able to download the JPEG images.
• Shooting information for downloaded images may be altered or deleted.
• Images cannot be downloaded if there is a large quantity of images in the camera 

(approximately 1,000 images).
• It may take several minutes after connecting the camera and your computer until the 

PTP function is operational.
• Vertically shot images become horizontal when downloaded, or an image does not 

rotate even if you use the Rotate command.
In addition to the above restrictions, you may not be able to download images correctly 
depending on your OS version and computer environment.
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Working with Images in the ZoomBrowser EX

This chapter explains functions of the ZoomBrowser EX, such as shot image 
display, editing, saving, printing and processing RAW images.

For more information on the restrictions of the ZoomBrowser EX and RAW Image 
Task, refer also to the source listed below.

ZoomBrowser EX

Readme: Click the [Start] button  select [All Programs] ([Programs] in versions 
other than Windows XP)  [Canon Utilities]  [ZoomBrowser EX]  
[ZoomBrowser EX README].

RAW Image Task

Readme: Click the [Start] button  select [All Programs] ([Programs] in versions 
other than Windows XP)  [Canon Utilities]  [RAW Image Task]  [RAW 
Image Task Readme].

Click on the item to display its page.
Starting the ZoomBrowser EX .......................................................................... 2-2

Image Display and Folder Handling ................................................................. 2-3

Image Display .................................................................................................. 2-3

Folder Structure and File Names..................................................................... 2-3

Handling the Folders........................................................................................ 2-3

Registering Frequent Use Folder..................................................................... 2-3

Selecting the Image Display Mode ................................................................... 2-4

Zoom Mode...................................................................................................... 2-4

Scroll Mode...................................................................................................... 2-5

Preview Mode .................................................................................................. 2-6

Viewer Window ................................................................................................ 2-7

Properties Window........................................................................................... 2-8

View & Classify Function................................................................................... 2-8

Viewing the Images as a Slide Show............................................................... 2-8

Renaming the Multiple Files............................................................................. 2-9

Classifying the Images into Folders ...............................................................2-10

Searching Images ..........................................................................................2-10

Editing Function ...............................................................................................2-11

Editing Images ...............................................................................................2-11

Merging Images .............................................................................................2-11

Processing RAW Images ...............................................................................2-12

Exporting Function ..........................................................................................2-14

Exporting Still Images ....................................................................................2-14

Exporting Shooting Properties .......................................................................2-14

Exporting an Image as a Screen Saver .........................................................2-15

Exporting an Image as Wallpaper..................................................................2-15

Writing Images to a CD..................................................................................2-16

Printing Images ................................................................................................2-16

One Photo per Page Printing .........................................................................2-16

Index Printing .................................................................................................2-17

Layout Printing ...............................................................................................2-17

Printing with Easy-PhotoPrint ........................................................................2-18

Printing Using Other Software .......................................................................2-18

Internet Function ..............................................................................................2-19

Sending an Image by E-mail..........................................................................2-19

Using CANON iMAGE GATEWAY ................................................................2-19

Registering as a Member of CANON iMAGE GATEWAY or Changing the 

Connection Information..................................................................................2-19

Displaying the Top Page or Photo Album Page of CANON iMAGE 

GATEWAY........................................................................................ 2-19

Registering an Image in CANON iMAGE GATEWAY....................................2-20

Modifying ZoomBrowser EX Settings ............................................................2-20

Task Button Display Settings .........................................................................2-20

Specifying Preferences ..................................................................................2-20
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Starting the ZoomBrowser EX

When sound is recorded in an image shot with an EOS-1D series camera, the sound file 
is displayed with a [ ]. For playback of the sound, select the [Edit] menu  [Play 
Sound].
The mark attached to the folder containing the images downloaded with 
CameraWindow is stored until you quit ZoomBrowser EX.

[ ] is displayed on images shot with AEB.
ZoomBrowser EX is compatible with Color Management System (compatible color 
spaces: sRGB, Adobe RGB). When the [Adjust color of images using monitor profile] 
checkbox in the [Color Management] in the preferences (p.2-20) is checkmarked, 
sRGB and Adobe RGB images are displayed in the same colors.

Double-click on the [ZoomBrowser EX] icon on the desktop.
Main window appears.
When you download images with 
[CameraWindow] (p.1-4), the 
ZoomBrowser EX starts automatically and 
the downloaded images are displayed in 
the main window.
Alternatively, you can start the 
ZoomBrowser EX by clicking the [Start] 
button  selecting [All Programs] 
([Programs] in versions other than 
Windows XP)  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX].

Task buttons
You can perform various operations from 
6 types of buttons (p.2-8 to p.2-20).

Click to show/hide the task buttons.

Folder area
The images in the selected folder are 
displayed in the image display area.
[ ] is automatically attached to the folder 
containing the images downloaded with 
CameraWindow.

Displays the drives and folders on the 
computer (p.2-3).

You can switch between showing and 
hiding the task buttons and folder area.

Add to Favorites button (p.2-3)

Displays the registered favorite folders 
(p.2-3).

Menu bar
Contains the same functions as the task 
button functions.

Displays the path of the folder selected in the folder area.

Displays the number of images selected.

You can change the display mode of 
the image display area (p.2-4 to p.2-6).

Image display area
The images inside the folder selected in 
the folder area are displayed.

Displayed on images that are protected.

Displayed on RAW images.

Displays the selected image in the viewer window (p.2-7).
Displays the selected image in the properties window (p.2-8).

Displays the selected images as a slide show (automatic playback) (p.2-8).
You can search for images by condition (p.2-10).

You can delete the selected image or folder.

You can rotate the selected image.

Main Window
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Image Display and Folder Handling

The images in the folder selected in the folder area are displayed in the image display area.

Images shot with the camera are saved in the memory card’s [DCIM] folder, with the following 
folder structure and file names.

Select the folder where the 
images to be displayed are saved.

The images in the folder are displayed in 
the main window.

The “xxx” in the folder names represent a number between 100 to 999.
The folder structure for the EOS-1D Mark II N, EOS-1Ds Mark II and EOS-1D Mark II 
CF card and SD card is the same.
When you perform DPOF settings on the camera, a [MISC] folder is created. The files 
that manage the DPOF settings are saved in the [MISC] folder.

When Adobe RGB is specified, the file names of images shot with the EOS-1D Mark II N, 
EOS-1Ds Mark II, EOS-1D Mark II, EOS 5D, EOS 350D DIGITAL, and EOS 20D have an 
underbar “ _ ” as the first character.

Image Display

Folder Structure and File Names

xxxCANON 
or 

xxxEOS5D

DCIM

CANONMSC
The folder that holds the image control files in the [DCIM] folder.

Cameras other than EOS-1D series cameras and EOS 5D camera

The “YYYY” in the file names represents a number between 0001 and 9999.

File name Image type/Camera used
IMG_YYYY.JPG JPEG image
IMG_YYYY.CR2 RAW 

image
EOS 5D, EOS 350D DIGITAL, EOS 20D

IMG_YYYY.CRW EOS 300D DIGITAL, EOS 10D, EOS D60, 
EOS D30

CRW_YYYY.THM Image for displaying the camera’s index

EOS-1D series cameras

The camera specific character string set at the time of factory shipment 
appears in “****” of the file name.
The camera specific character string set at the time of factory shipment or 
set in the camera appears in “****” of images shot with the EOS-1D Mark II N.
The “YYYY” in the file names represents a number between 0001 and 9999.

File name Image type/Camera used
****YYYY.JPG JPEG image
****YYYY.CR2 RAW 

image
EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II

****YYYY.TIF EOS-1Ds, EOS-1D
****YYYY.WAV Audio file

xxxEOS1D

You can handle the folder on the menu that appears by right-clicking the folder.

You can register a frequently used folder as a [Favorite Folders].

Right-click on the folder and select an option from the menu that 
appears.

1 Select the [All Folders] tab.

2 Select the folder you want to 
register and then click the [Add to 
Favorites] button.

3 Select the [Favorite Folders] tab.
The registered folder appears.
Alternatively, you can register a favorite 
folder in the dialog box displayed when 
you click the [Add] button in the [Favorite 
Folders] tab sheet.
To remove the registered folder, click the 
[Remove] button in the [Favorite Folders] 
tab sheet.

The removed registered folder is deleted only from the [Favorite Folders] tab sheet and 
the actual folder or images inside the folder are not deleted.

Handling the Folders

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the image display mode from 3 types (Zoom Mode, Scroll Mode and Preview 
Mode).
Also, in the viewer window, you can display images individually, and in the properties window, 
you can check shooting information and enter comments, etc.

You can zoom into the target folder and display the images inside the folder.

Select the [Zoom Mode] tab.

To select an image, click the target image.
To select sequential images, click the first image and then hold down the <Shift> key and 
then click the last image.

To select multiple images, hold down the <Ctrl> key and click the images.
If you move the mouse cursor on top of the image and wait for a while, the image will be 
displayed individually.
You can zoom in by double-clicking inside the folder frame.

You can set the zoom speed when a folder is selected in the preferences (p.2-20).

Zoom Mode

Returns to the display of the folder 
previously displayed.

Returns to the display of the folder 
before [ ] is clicked.

Displays the folder above.
You can select or deselect all the images and folders.

You can set the information to be displayed for the images.

Displays the image enlarged.
When the image is enlarged, the [Navigator] window 
appears and you can check the enlargement position.

Displays the image reduced.

Drag left or right to display the image enlarged or reduced.

You can display only the images that match a “Rating”.

To select an image after enlarging or reducing it, 
click this button before selecting it.

Zoom Mode tab

Folder area
The images in the selected folder are displayed 
in the image display area.

The images are displayed to fit the size of the window.

Image display area
The images inside the folder selected in 
the folder area are displayed.

When the image is displayed as an enlargement, you can move the 
display position by dragging on top of the image.
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You can display the images in multiple folders at the same time.

Select the [Scroll Mode] tab.

To select an image, click the target image.
To select sequential images, click the first image and then hold down the <Shift> key and 
then click the last image.

To select multiple images, hold down the <Ctrl> key and click the images.
If you move the mouse cursor on top of the image and wait for a while, the image will be 
displayed individually.

You can set the level of the folder that displays the images in the preferences (p.2-20).

Scroll Mode

Returns to the display of the folder previously displayed.
Returns to the display of the folder before [ ] is clicked.
Displays the folder above.
You can select or deselect all the images and folders.
You can set the information to be displayed for the images.

Drag left or right to display the image enlarged 
or reduced.
You can display only the images that match a “Rating”.

By clicking the [ ] or double-clicking 
the folder, you can display or hide the 
folder or the images inside the folder.

Scroll Mode tab

Folder area
The images or folders in the selected 
folder are displayed in the image 
display area.

The number of images inside the 
folder, the number of audio files and 
the number of folders are displayed.

Image display area
The images or folders inside the folder 
selected in the folder area are displayed.
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You can select an image displayed as a thumbnail and display it individually.

Select the [Preview Mode] tab.

To select multiple images, hold down the <Ctrl> key and click the images.
To select sequential images, click the first image and then hold down the <Shift> key and 
then click the last image.
You can switch between showing and hiding each item by clicking the [ ] button.

If you move the mouse cursor on top of the thumbnail image and wait for a while, the image 
will be displayed individually.
If you double-click on a folder in the thumbnail image display area, the images inside the 
folder will be displayed.

You cannot change the file name or edit an image that is protected.

Preview Mode

Returns to the display of the folder previously displayed.
Returns to the display of the folder before [ ] is clicked. Displays the folder above.

You can select or deselect all the images and folders.
You can set the information to be displayed for the images.
You can display only the images that match a “Rating”.

You can change the file name.

You can set a “Rating”.

You can set protection.

You can enter comments.

The [View/Modify Keywords] dialog box 
appears and you can set a keyword.

Displays the histogram (brightness 
distribution).

Displays the shooting information.

Thumbnail image display area
The images inside the folder selected in 
the folder area are displayed.
The selected image is displayed in the 
image display area.

Image display area
Displays the image selected in the 
thumbnail image display area.

Preview Mode tab

Folder area
The images in the selected folder are displayed 
in the thumbnail image display area.

When a sound file is selected, the information of 
the sound file is displayed. If the [Play Sound] 
button is clicked, the sound is played back.

You can show/hide the image information area.Displays the previous image.

Displays the next image.
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You can display images in individual windows.

Double-click the image.
The selected image displays in the viewer window.

Viewer Window

Displays the next image.*

Displays the previous image.*

You can divide the window and display 
multiple images.*

When you have divided the window and 
displayed multiple images, you can link the 
images by making the enlargement ratio and 
display position of the images the same.*

Displays the image enlarged.
When the image is enlarged, the [Navigator] window appears 
and you can check the enlargement position.

Displays the image reduced.

Drag left or right to display the image enlarged 
or reduced.

When the image is displayed as an enlargement, you can move the display position by dragging 
on top of the image.

Displays the image to fit the size of the window.

You can edit the image (p.2-11).

You can set a “Rating”.

You can display the AF point used when the shot was taken.

You can display the image in full screen.
To return to the original view, click the image.

Only displayed on RAW images.
You can process a RAW image and display it.

You can print the image.

You can display the shooting information.

* When you have selected multiple images and opened the viewer window, you can switch between the 
selected images. If you have selected one image and opened the viewer window, you can switch 
between images inside the same folder.

When the shot was taken with automatic AF point selection, multiple active AF points 
might be displayed.
You can change the processing parameters of RAW images (p.2-12).
You can set in the preferences the items that are displayed as the shooting 
information (p.2-20).

You can set the image to 100% view 
(actual pixel size).

Image display area



2-8

1
2
3
4
5

Cover/Table of  
Contents

Downloading Images  
from the Camera,  
and Camera Settings

Working with  
Images in the  
ZoomBrowser EX

Remote Shooting in  
the EOS Capture

Troubleshooting  
and Uninstalling  
the Software

Index

Setting the EOS 5D  
and EOS-1D Series  
Cameras

Introduction

You can enter information and comments for the images.

1 Select the image in zoom mode (p.2-4) or scroll mode (p.2-5).

2 Click the [Properties] button (p.2-2).
The properties window appears.

* When you select multiple images and open the properties window, you can switch the image 
displayed.

You can switch between showing and hiding each item by clicking the [ ] button.

You cannot change the file name or edit an image that is protected.

If you select a sound file, the information relating to that sound file is displayed.

Properties Window

You can change the file 
name.

You can set a “Rating”.
You can set protection.

You can enter comments.

Displays the shooting 
information.

Displays the histogram 
(brightness distribution).

The [View/Modify 
Keywords] dialog box is 
displayed and you can set 
a keyword.

Displays the viewer window (p.2-7).

Displays the Help.

Displays the previous image.*
Displays the next image.*

View & Classify Function

You can view the images as a slide show (automatic playback).

1 Select the images.

2 Click [View & Classify].
The [View & Classify] menu appears.

3 Click [View as a Slide Show].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

Viewing the Images as a Slide Show
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5 Click [Start Slide Show].
The slide show begins.

You can end the slide show by pressing the <Esc> key on the keyboard.

You can set a “Rating”.

If clicked when an image is displayed, 
the image appears selected or 
deselected in the main window after 
the slide show ends.

If clicked when an image is displayed, 
the printing dialog box (p.2-16) 
appears after the slide show ends, and 
you can print the selected images.

Displays the previous image.

Pauses the slide show.

Displays the next image.

Ends the slide show.

You can rename the multiple files in a single operation.

1 Select the images.

2 Click [View & Classify].
The [View & Classify] menu appears.

3 Click [Rename Multiple Files].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the 
settings are executed.

Renaming the Multiple Files
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You can classify images according to the date and time they were shot.

1 Select the images.

2 Click [View & Classify].
The [View & Classify] menu appears.

3 Click [Classify into Folder].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the 
settings are executed.

Classifying the Images into Folders
You can search for images with set conditions.

1 Select in the folder area or in the image display area the folder or 
drive to be searched (p.2-2).

2 Click [View & Classify].
The [View & Classify] menu appears.

3 Click [Search].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Start Search].
The search begins and the images that match the set conditions are displayed.

6 Click [Finish].
The display returns to the main window.
Select [Search Results] in the folder area to display the searched images.
The images in [Search Results] are stored until you search for an image with set 
conditions again or exit ZoomBrowser EX.

Searching Images



2-11

1
2
3
4
5

Cover/Table of  
Contents

Downloading Images  
from the Camera,  
and Camera Settings

Working with  
Images in the  
ZoomBrowser EX

Remote Shooting in  
the EOS Capture

Troubleshooting  
and Uninstalling  
the Software

Index

Setting the EOS 5D  
and EOS-1D Series  
Cameras

Introduction

Editing Function

You can edit your images with red-eye correction, brightness/color correction, sharpness, 
trimming, text insertion, automatic correction, etc. Also, you can transfer an image to other 
image editing software.

1 Select one image.

2 Click [Edit].
The [Edit] menu appears.

3 Click [Edit Image].
The settings window appears.

4 Select the contents to be edited 
and then click [Finish].

For detailed information, click the [?] 
button and refer to the Help displayed.
To transfer and edit your image in different 
image editing software, select [Edit with 
external image editor], click the [Manage 
List] button and then select the image 
editing software to be used.

5 Edit the image and then click the [Save As] button.
The [Save As] dialog box appears.

6 Select the save destination and click the [Save] button.
The edited image is saved.

You cannot select multiple images and edit.
You cannot edit RAW images here. You can edit RAW images with RAW Image Task 
(p.2-12).
Edited images cannot be reverted to their original condition. We recommend saving 
edited images under a different name.

Editing Images
You can merge up to 4 JPEG images to create a panorama image.

1 Select multiple images.

2 Click [Edit].
The [Edit] menu appears.

3 Click [Stitch Photos].
The PhotoStitch starts and the main 
window appears.
Follow the instructions displayed to merge 
the images.
For detailed information, click the [?] 
button and refer to the Help displayed.

You cannot merge RAW images in the PhotoStitch.
Merging may not be successful when more than 4 images are merged.

Merging Images
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You can specify the same processing parameters for RAW images as for the camera so that 
the RAW images are optimized for their intended purpose.
Also, you can convert RAW images to TIFF images or JPEG images and save or transfer them 
to other image editing software, as well as attach ICC profiles.

1 Select the RAW image.

2 Click [Edit].
The [Edit] menu appears.

3 Click [Process RAW Images].
The RAW Image Task starts and the main 
window appears.
Refer to the next page for an explanation 
of the RAW Image Task window.
For detailed information, refer to [Help] 
menu and the [RAW Image Task Help].

4 Adjust the image.
Adjust the image with the [Image Quality Adjustment] window.

5 Click [Save] in the toolbar.
The [Save Images] window appears.

6 Specify desired settings.

7 Click the [Save] button.
The processing window appears and the image is saved.

8 Select the [File] menu  [Exit].
The RAW Image Task exits.

Processing RAW Images Because only the processing parameter settings are changed and they are not added 
to the RAW image, you can change the parameters multiple times or revert to the 
condition when the image was shot. In addition, there is hardly any of the image 
deterioration that accompanies processing parameter changes.
When the [Preview] is selected, every time you set a processing parameter, the 
image is processed/redisplayed. To process multiple processing parameters in one 
operation, deselect the [Preview]. After setting multiple processing parameters, click 
the [Update] button and the multiple processing parameters will be processed/
redisplayed in one operation.
The time needed after setting of processing parameters for processing and displaying 
an image is approximately 1 to 3 seconds.
• The above time is only an estimate. Processing times vary widely depending on the 

camera model used to take the RAW image, the type of computer, and the subject of 
the photo. 

• Processing times are based on Canon testing standards. 
(When using the following: OS: Windows XP, CPU: 2.2 GHz Pentium 4; RAM: 512MB)

You can attach ICC profiles to TIFF and JPEG images converted and saved from 
RAW images. An ICC profile contains color information, such as color properties and 
color spaces of devices which are authorized by International Color Consortium 
(ICC). With this ICC profile, many Color Management Systems can minimize the color 
differences between devices.
RAW Image Task is compatible with Color Management System. 
In addition, two types of color space are compatible with RAW Image Task, and if the 
[Adjust color of images using monitor profile] checkbox in the [Color Management] in 
the preferences of ZoomBrowser EX (p.2-20) is checkmarked, sRGB and Adobe 
RGB images displayed in RAW Image Task are displayed in the same color.
sRGB: Windows standard color space. Also widely used for the standard color 

space for monitors, digital cameras, scanners and other devices.
Adobe RGB:A wider color space than sRGB. Mainly used for printing for business 

purposes.
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bv

White balance files saved in EOS-1D series cameras other than EOS-1D Mark II N 
cannot be used with other camera models.

You can download Picture Style files (p.4-11) from the Canon web site.
White balance files and tone curve files saved in EOS-1D series cameras other than 
EOS-1D Mark II N are compatible with RAW Image Task for both Windows and 
Macintosh.
Tone curve files for the EOS-1Ds Mark II and EOS-1D Mark II are compatible.
Tone curve files for the EOS-1Ds and EOS-1D are compatible.

* Where you have selected multiple RAW images and started RAW Image Task, you can switch between 
the displayed images.

The settings at the time of shooting are displayed in bold/italics in the list box of the 
[Image Quality Adjustment] window.
The processing parameters you have set can be applied to other images by copy/paste, 
save/download in the [Development Conditions] menu in the [Edit] menu.
With the EOS-1Ds Mark II, EOS-1D Mark II, EOS-1Ds and EOS-1D, you can save an 
adjusted tone curve or white balance as a file. Also, you can register the saved files in 
the camera (p.4-13, p.4-14).
The [Image Quality Adjustment] window is displayed when you select a RAW image 
shot with the EOS-1D Mark II N and EOS 5D. The displayed information varies 
depending on the camera used to shoot.

When the image is displayed as an 
enlargement, you can move the display 
position by dragging on top of the image.

Thumbnail image display area
The selected image is processed and 
displayed in the image display area.

Image display area
The image selected in the thumbnail image 
display area is processed and displayed.

Drag left or right to display the image 
enlarged or reduced.

Toolbar

RAW Image Task Main Window

The previous image is displayed. *

The next image is displayed. *

You can set checkmarks on images selected 
in the thumbnail image display area.

You can show/hide the [Image Quality Adjustment] window.

You can save the adjusted image.

You can rotate a selected image.

You can select or deselect all the images.

You can transfer the image to the specified image editing software.

Click this button before selecting the image.
Displays the image enlarged.

Displays the image reduced.

You can show/hide the [Histogram] window.

You can show/hide the [Navigator] window.
Displays the shooting information.
The images are displayed to fit the size 
of the window.

The image is displayed at 100% 
(actual pixel size).

The zoom ratio of the image is displayed.

When checkmarked, the specified 
processing parameters are 
applied to the image each time.

EOS 5D

Sets each processing parameter.

You can revert to the processing 
parameters of when the image was shot.

The specified processing parameters 
are applied to the image.

Image Quality Adjustment Window

You can load Picture Style files saved on 
your computer and apply them to images. 
(This function is compatible with the EOS-1D 
Mark II N and EOS 5D only.)

EOS-1D Mark II N
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Exporting Function

You can change the size of JPEG images as well as convert them to other image types and 
save them.

1 Select the images.

2 Click [Export].
The [Export] menu appears.

3 Click [Export Still Images].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting Still Images
You can export as a text file the shooting properties recorded to the image when the shot was 
taken.

1 Select the image.

2 Click [Export].
The [Export] menu appears.

3 Click [Export Shooting 
Properties].

The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the settings are executed.

Exporting Shooting Properties
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You can export a JPEG image as a file for a computer screen saver.

1 Select the image.

2 Click [Export].
The [Export] menu appears.

3 Click [Export as a Screen Saver].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting an Image as a Screen Saver
You can export a JPEG image as a file for wallpaper for a computer.

1 Select the image.

2 Click [Export].
The [Export] menu appears.

3 Click [Export as a Wallpaper].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Finish].
The processing window appears and the settings are executed.

You cannot export RAW images.

Exporting an Image as Wallpaper
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You can write images to a CD-R/CD-RW.
This function is only compatible with a computer that has Windows XP pre-installed and is 
equipped with a standard CD-R/CD-RW drive.

1 Select the images.

2 Click [Export].
The [Export] menu appears.

3 Click [Backup to CD].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Start Backup].
The processing window appears and the settings are executed.

Writing Images to a CD

Printing Images

You can print one photo per page.

1 Select the image.

2 Click [Print].
The [Print] menu appears.

3 Click [One Photo per Page Print].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Print] button.
The processing window appears and the image is printed.

If Easy-PhotoPrint, the dedicated printing software for Canon BJ Printers is installed, it 
becomes the default software for printing. To cancel printing with Easy-PhotoPrint and 
switch to printing with ZoomBrowser EX independently, select [Use the Print Function in 
ZoomBrowser EX] in the [Printing] tab sheet of the preferences (p.2-20).

One Photo per Page Printing



2-17

1
2
3
4
5

Cover/Table of  
Contents

Downloading Images  
from the Camera,  
and Camera Settings

Working with  
Images in the  
ZoomBrowser EX

Remote Shooting in  
the EOS Capture

Troubleshooting  
and Uninstalling  
the Software

Index

Setting the EOS 5D  
and EOS-1D Series  
Cameras

Introduction

You can print the images in index format.

1 Select the images.

2 Click [Print].
The [Print] menu appears.

3 Click [Index Print].
The settings window appears.

4 Specify desired settings.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Print] button.
The processing window appears and the images are printed.

Index Printing
You can layout images and print them.

The settings displayed in the dialog box vary depending on the printer being used.

1 Select the images.

2 Click [Print].
The [Print] menu appears.

3 Click [Layout Print].
The settings window appears.

4 Select the items you want printed.
For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click [Open Layout Print].
The PhotoRecord starts and the main window appears.

6 Click [Select Printer & Album Type] and specify.
For detailed information, refer to the [Help] menu.

7 Click [Select Paper] and specify.
Selects the media type.
For detailed information, refer to the [Help] menu.

Layout Printing

Selects the printer to print.

Displays the printer properties.

Selects the album type.
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Easy-PhotoPrint is software exclusively for use with Canon BJ printers. If Easy-PhotoPrint is 
installed on your computer, you can print with Easy-PhotoPrint.

8 Click [Decorate Album] and specify.
Selects the image decoration.
For detailed information, refer to the [Help] menu.

9 Click [Add Titles & Captions] and specify.
Sets a title and/or caption to be printed with the image.
For detailed information, refer to the [Help] menu.

10Click [Print].
The settings appear.

11 Click the [Print] button.
The images are printed.

1 Select an image.

2 Click [Print].
The [Print] menu appears.

3 Click [Easy-PhotoPrint].
Easy-PhotoPrint starts up.
Follow the instructions displayed to print 
the images.

Printing with Easy-PhotoPrint

You can select software other than ZoomBrowser EX and print.

1 Select an image.

2 Click [Print].
The [Print] menu appears.

3 Click [Print Using Other Software].
The settings window appears.

4 Select the software for printing 
and specify desired settings.

For detailed information, click the [?] 
button and refer to the Help displayed.

5 Click the [Launch Software] button.
The software selected in step 4 starts. Follow the instructions displayed to print the 
images.

Printing Using Other Software
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Internet Function

You can attach an image to an e-mail and send it.

CANON iMAGE GATEWAY is a free internet online service (no joining or annual fee) restricted 
to users who have purchased a Canon digital camera. 
To connect to CANON iMAGE GATEWAY, it is necessary to register as a member beforehand. 
Perform member registration from the installer panel displayed when you insert the Solution 
Disk provided into the CD-ROM drive of your computer. You can also use the following 
procedure to register as a member.
For details on the CANON iMAGE GATEWAY, refer to the Help of CANON iMAGE GATEWAY.

1 Select the image.

2 Click [Internet].
The [Internet] menu appears.

3 Click [Email Images].
The settings window appears.

4 Specify desired settings and then 
click [Send or Save].

For detailed information, click the [?] 
button and refer to the Help displayed.

5 Specify desired settings.
For detailed information, click the [?] button and refer to the Help displayed.

6 Click [Finish].
Your e-mail software starts.
Enter the necessary information and then send the message.

Sending an Image by E-mail

Using CANON iMAGE GATEWAY

You can register as a member of CANON iMAGE GATEWAY as well as change the connection information.

You can display the top page or photo album page of CANON iMAGE GATEWAY in the 
browser software you are using.

1 Click [Internet].
The [Internet] menu appears.

2 Click [CANON iMAGE GATEWAY 
Register].

The settings dialog box for member 
registration and connection information 
appears.
If you have not yet registered as a member, 
click the [Register] button and register 
following the instructions in the dialog box.
If you have already registered as a member, 
you can change the connection information 
as well as add a camera to register.

1 Click [Internet].
The [Internet] menu appears.

2 Click [CANON iMAGE GATEWAY 
View Top Page] or [CANON 
iMAGE GATEWAY Album].

When the connection window appears and 
connection is completed, the browser 
software you are using starts and the 
CANON iMAGE GATEWAY top page or 
photo album page appears.

Registering as a Member of CANON iMAGE 
GATEWAY or Changing the Connection Information

Displaying the Top Page or Photo Album 
Page of CANON iMAGE GATEWAY
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You can register an image in the photo album function of CANON iMAGE GATEWAY.

1 Select the image.

2 Click [Internet].
The [Internet] menu appears.

3 Click [Upload to CANON iMAGE 
GATEWAY].

The settings window appears.

4 Specify the desired settings and 
then click the [Next] button.

For detailed information, click the [?] 
button and refer to the Help displayed.

5 Check the contents of the displayed dialog box and click the 
[Upload] button.

When the connection window appears and connection is completed, the browser 
software you are using starts and the image registered in the photo album page 
appears.
For detailed information, click the [?] button and refer to the Help displayed.

Registering an Image in CANON iMAGE 
GATEWAY

Modifying ZoomBrowser EX Settings

You can specify which task buttons to show or hide.

You can set various ZoomBrowser EX function settings.

1 Select the [Tools] menu  [Customize].

2 Select the items you want to show.
Deselect the items you do not want to show.

1 Select the [Tools] menu  [Preferences].

2 Specify desired settings.
For detailed information, refer to the [Help] menu.

Task Button Display Settings

Specifying Preferences
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Remote Shooting in the EOS Capture

This chapter explains how to use the EOS Capture for taking shots remotely 
from your computer.

For more information on the restrictions of the EOS Capture, refer also to the source 
listed below.

Readme: Click the [Start] button  select [All Programs] ([Programs] in versions 
other than Windows XP)  [Canon Utilities]  [EOS Capture xx] (“xx” is 
the version)  [EOS Capture Readme].

Remote shooting in the EOS Capture is available with the EOS-1D Mark II N, EOS-1Ds 
Mark II, EOS-1D Mark II, EOS-1Ds, EOS-1D, EOS 5D, EOS 350D DIGITAL and EOS 20D.
EOS Capture cannot be used when the camera’s communication mode is set to [Print/PTP] 
or [PTP]. Set the camera’s communication mode to [PC connect.], [PC connection] or 
[Normal] (p.1-1).

Click on the item to display its page.
Remote Shooting................................................................................................3-2

Single-frame Shooting .....................................................................................3-2

Timer Shooting.................................................................................................3-3

Interval Timer Shooting....................................................................................3-3

Specifying the Camera Settings........................................................................3-3

Camera Settings ..............................................................................................3-3

White Balance Adjustment...............................................................................3-4

Specifying the Save Destination ......................................................................3-4
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Remote Shooting

You can take shots by remote controlling your camera from a computer.

1 Connect the camera to the computer (p.1-2).
The [CameraWindow] appears.
When the ZoomBrowser EX is running, select [Acquire & Camera Settings]  
[Remote shooting] to start [CameraWindow].

2 Select the [Remote shooting] tab and click the [Starts Remote 
Shooting] button.

The [Select Folder] dialog box 
appears.

3 Select the destination folder to which images will be saved and 
click the [OK] button.

The ZoomBrowser EX and EOS Capture start and the EOS Capture main window 
appears.

Single-frame Shooting 4 Specify desired settings.

The above window shows information displayable when the EOS 5D is connected. 
The displayed information varies depending on the camera model connected.

5 Click the [Shoot] button.
The shot image is saved in the specified folder and is displayed in the ZoomBrowser 
EX.
Alternatively, you can press the camera’s shutter button to take the shot.
To exit the EOS Capture, select the [File] menu  [Exit].

If the camera is not ready for shooting (the lens is not attached, etc.), you cannot 
perform the operation as explained.
When you are using auto focus, you cannot take shots if the camera cannot focus. In 
this case, focus manually.
Bulb exposure is not available.

Alternatively, you can press the space bar to shoot.
The number of available shots changes depending on the available capacity on your 
computer’s hard disk (p.3-3).
The time to transfer a RAW image shot with EOS Capture to your computer is 
approximately 4 to 7 seconds.
• The above time is only an estimate. Transfer times vary widely depending on the 

camera model used, the type of computer, and the subject of the photo.
• Transfer times are based on Canon testing standards.

(When using the following: OS: Windows XP, CPU: 2.2 GHz Pentium 4; RAM: 512MB)
• The times for images shot in JPEG will be shorter than those shown above.

Allows you to specify and 
check the camera settings 
(p.3-3).

You can rotate and download 
the shot images regardless of 
the camera position. Each time 
you click the button, the image 
rotates 90°. 
* When using the rotate 

function, enable the rotate 
function in the [Save 
settings] dialog box (p.3-4).

Click to show/hide the 
white balance 
adjustment dialog box.

[Shoot] button
Click the [Shoot] button to take 
a shot.

You can adjust the white 
balance (p.3-4).

Displays the status.
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You can automatically take a shot when the specified time elapses.

You can automatically take shots by setting the interval between shots and the number of shots 
to be taken.

1 Select the [Tool] menu  [Timer Shooting]
The [Timer shooting setting] dialog box appears.

2 Enter a delay time and click the [Start] button.
Enter a value between 0 seconds and 99 minutes 59 seconds in 1-second 
increments.
The shot is taken when the specified time elapses.

1 Select the [Tool] menu  [Timer Shooting].
The [Timer shooting setting] dialog box appears.

2 Checkmark the [Interval timer shooting] checkbox.

3 Enter the shooting interval and the number of shots. Then click 
the [Start] button.

Enter a value between 5 seconds and 99 minutes 59 seconds in 1-second 
increments.
You can shoot up to 9999 photos with EOS-1D series cameras, and up to 999 photos 
with cameras other than EOS-1D series cameras.
Shooting is performed at the specified interval and for the specified number of shots.

On some types of computers, if you set a short interval between shots and there is 
insufficient time to download and save the images, it may not be possible to take shots at 
the specified interval. In this case, set a longer interval between shots and take the shots 
again.

Timer Shooting

Interval Timer Shooting

Specifying the Camera Settings
You can check and change the settings in the camera from your computer remotely.

You can check and specify the camera settings.
With the EOS-1D, you can only check the content of the settings but you cannot 
specify settings.

1 Check the camera settings.

* is not displayed with the EOS-1Ds and EOS-1D.
The ISO bracketing of * is not displayed with EOS 5D, EOS 350D DIGITAL and EOS 20D.
The FEB of * is not displayed with the EOS 350D DIGITAL and EOS 20D.
The above window shows information displayable when the EOS 5D is connected. The 
displayed information varies depending on the camera model connected.

Camera Settings

Shooting mode
Displays the shooting mode.
(You can change the settings for the EOS-
1D series cameras, excluding the EOS-1D.)

White Balance
Displays/specifies 
the white balance.

Exposure compensation
Displays/specifies the exposure 
compensation value.

Image recording quality
Displays/specifies the image 
recording quality.

ISO Speed
Displays/specifies the ISO speed.

Aperture value
Displays/specifies Av (aperture value).
(Not displayed when Shutter-priority AE or 
Program AE is specified for the shooting mode.)

Shutter speed
Displays/specifies Tv (shutter speed).
(Not displayed when Aperture-priority AE or Program AE is specified for the shooting mode.)

Save destination display 
(p.3-4)
Displays the destination folder 
to which images will be saved.
(When you select the [Save 
also on the camera’s memory 
card], the camera/computer 
icon is displayed, and when 
you deselect the checkbox, the 
computer icon is displayed.)

Metering mode
Displays/specifies 
the settings of the 
metering mode.

AF mode
Displays the AF mode.

Drive mode
Displays the drive mode.

Warning display
Displayed when the remote shooting is 
impossible due to inappropriate settings.

Shots to Go
Displays the number of 
available shots.

Battery status
When you are using a battery, 
[  ] is displayed. When you are 
using the AC Adapter Kit (optional) or 
DC Coupler Kit, [  ] is displayed.

Bracket shots*
Displays when AEB, FEB, white 
balance bracketing or ISO 
bracketing is set.
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You can compensate white balance with the blue/amber/green/magenta digital filter.
If the dialog box has not appeared, click the [ ] button.

4 Click the icon to be set.
The icon displayed here shows exposure 
compensation as an example.

5 Use the buttons to change a value.

The changed settings are applied to the camera.

Before you specify the settings, be sure to check that the camera is ready for 
shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 
cannot make some of the settings.
Set functions which you cannot set with EOS Capture (drive mode, AF mode etc.) in 
the camera.

Click the compensation position.

The changed settings are applied to the camera.

Allows you to decrease the value by 1 step.

Specifies the minimum value.

Allows you to increase the value by 1 step.

Specifies the maximum value.

White Balance Adjustment

Compensate magenta.

Compensate green.

Compensate blue. Compensate amber.

Displays the 
compensation value.

You can specify save destination folders and file names.

Save settings dialog box

1 Select the [File] menu  [Save setting].
The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Specifying the Save Destination

Allows you to change the destination folder to which images 
will be saved. The path and name of the save folder are 
displayed next to the [Browse] button.

Cancels all the settings, and restores the settings to their original ones.

Checkmark to also save images on the 
memory card in the camera.

Use this field to enter a file name when saving 
an image. The file name can consist of up to 
18 characters.

Enter a sequential number with a range of 0000 
to 9999 that is added to the end of the file name.

Checkmark to enable use of the rotation function (p.3-2).

Applies the settings and closes the [Save settings] dialog box.
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Setting the EOS 5D and EOS-1D Series Cameras

This chapter explains the functions that can be set in the EOS 5D and EOS-
1D series cameras.

Refer to Chapter 1 for how to connect the camera and your computer (p.1-2).
Refer to Chapter 1 for settings for cameras other than the EOS 5D and EOS-1D series 
cameras (p.1-5).

Click on the item to display its page.
Camera Settings .................................................................................................4-2

Basic Settings.....................................................................................................4-2

Personal Function Settings...............................................................................4-3

Description of Personal Functions ...................................................................4-4

Checking, Saving, and Loading Personal Function Settings ...........................4-9

Shot Settings ....................................................................................................4-10

Picture Style...................................................................................................4-11

Specifying the Parameters.............................................................................4-12

Specifying the Tone Curve.............................................................................4-13

Specifying the Personal White Balance .........................................................4-14

Specifying the Color Matrix ............................................................................4-15

Specifying the JPEG Quality..........................................................................4-15



4-2

1
2
3
4
5

Cover/Table of  
Contents

Downloading Images  
from the Camera,  
and Camera Settings

Working with  
Images in the  
ZoomBrowser EX

Remote Shooting in  
the EOS Capture

Troubleshooting  
and Uninstalling  
the Software

Index

Setting the EOS 5D  
and EOS-1D Series  
Cameras

Introduction

Camera Settings
You can specify settings for the camera such as the camera owner’s name, the date and time, 
Personal Functions and all shot settings.

1 Select the [Set to Camera] tab.
The [Set to Camera] tab sheet 
appears.

2 Click the [Confirms/
changes camera settings] 
button.

The [Camera Settings] dialog box 
appears.

3 Select a tab and specify the camera settings.

With the EOS 5D, only the [Basic settings] tab and [Shoot settings] tab are displayed.
With the EOS-1Ds and EOS-1D, the [Basic Settings] tab and the [Detailed Settings] 
tab are displayed. In the [Detailed Settings] tab sheet, you can set Personal Functions 
(p.4-3), processing parameters (p.4-12) and personal white balance (p.4-14), and 
apply the settings to the camera.

You can set up Personal Functions and 
apply the settings to the camera (p.4-3).

You can specify camera owner’s name and shooting date/time on the camera, and 
confirm the camera properties data and the status of the battery and the memory card.

You can apply to the camera all settings 
relating to the images shot by the camera.

Basic Settings
You can specify the camera owner’s name and the date and time on the camera, and confirm 
the status of the camera’s battery and memory card.

1 Display the [Camera settings] dialog box.

2 Select the [Basic settings] tab.
The [Basic settings] tab sheet 
appears.

3 Specify desired settings.

* With the EOS 5D, EOS-1Ds and EOS-1D, the [Format] button is displayed in the CF card information 
display. You can initialize the CF card by clicking this button. Be careful as [Format] will delete the 
entire recorded contents on the CF card.

The above window shows information displayable when the EOS-1D Mark II N is 
connected. The displayed information varies depending on the camera model 
connected.

4 Click the [OK] button.
The settings are applied and the [Camera settings] dialog box closes.

Displays the information relating 
to the memory card inside the 
camera.*

Enter the camera owner’s name. 
You can enter up to 31 characters.

Imports the date and time 
from your computer.

Displays the information relating 
to the camera.

The battery level of the camera is 
indicated by [  ] or [  ].
When you are using the DC Coupler 
Kit supplied with the camera or the 
AC Adapter Kit (optional), [ ] is 
displayed.

Cancels all the settings and closes 
the dialog box.

Enter a value or click the [ ]/[ ] 
buttons to specify the date and time.

Applies the settings to the camera.

Applies the settings to the camera 
and closes the dialog box.
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Personal Function Settings
You can set Personal Functions tailored to different types of photography and apply those 
function settings to the camera. You can also save the specified settings on your computer and 
load the saved settings. 

These functions are compatible with the EOS-1D series only.

1 Display the [Camera settings] dialog box (p.4-2).

2 Select the [Personal functions] tab.
The [Personal functions] tab sheet 
appears.
With the EOS-1Ds and EOS-1D, 
select the [Detailed Settings] tab 
and click [Personal Functions] 
button.

3 Select a window in which you wish to specify settings from the 
list box.

With the EOS-1Ds and EOS-1D, select the tab to be set.

The selected window appears.
In the [Combination] window, you can check the specified Personal Function settings 
and the status of whether or not the settings are applied to the camera. You can also 
save and load the Personal Function settings (p.4-9).

Loads the details of the Personal Functions 
that have been specified on the camera.

Removes all the checkmarks from the 
windows.

Applies the settings to the camera and closes 
the dialog box.

Applies the settings to the 
camera.

Cancels all the settings and closes the dialog box.

4 Checkmark the box [ ] and specify any necessary settings (p.4-4 
to p.4-8).

If you enter a numerical value, values outside the valid range of settings are ignored.
If the Personal Function settings are saved on your computer, the saved settings can 
be loaded (p.4-9).

5 Check the settings and save them on your computer if necessary 
(p.4-9).

6 Click the [OK] button.
Applies the settings and closes the 
[Camera settings] dialog box.
When a Personal Function is applied to 
the camera, < > appears on the LCD 
panel.
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The  shown in this section provides brief descriptions of the Custom Function Settings 
for the respective camera functions. For more details, refer to “Custom Function Settings” in 
the camera’s Instruction Manual.

Disables the shooting modes
Checkmark the shooting modes you do not want to use.
Unwanted shooting modes can be skipped while you are selecting the shooting mode.
This makes selecting the desired shooting mode faster.
With the EOS-1Ds and EOS-1D, [Disable depth-of-field AE] is also displayed.

Disables the metering modes
Checkmark the metering modes you do not want to use.
Unwanted metering modes can be skipped while you are selecting the metering mode.
This makes selecting the desired metering mode faster.

Specifies the metering mode for manual exposure
Select the metering mode to be specified.
You can specify the metering mode to be used in the manual exposure mode. 
When you set the manual exposure mode, the metering mode selected here will be set 
automatically. In the manual exposure mode, this enables you to use a metering mode 
different from the one used in the AE modes. 

At least one checkbox must be left unchecked.

At least one checkbox must be left unchecked.

Description of Personal Functions

P.Fn-01

P.Fn-02

P.Fn-03

Sets the maximum and minimum shutter speeds to be used
Select the maximum and minimum shutter speeds from the list box.
For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the 
slowest, the shutter speed range will be 1/2000 to 1/60 sec.
This makes shutter speed selection faster and prevents a slow-speed sync. in aperture-
priority AE mode with the flash.

Sets the maximum and minimum apertures to be used
Select the maximum and minimum apertures from the list box.
For example, if you set 1.4 for the largest aperture and 8.0 for the smallest aperture, the 
usable aperture range will be f/1.4 to f/8.0.
You can better control the apertures used by setting the range of usable apertures.

If you set the maximum and/or minimum shutter speed to one that is not a full-stop 
increment (such as 1/750 sec.), the controllable and settable shutter speed range 
might not be as exact as you set it (A slight deviation may occur.). This applies if you 
also set Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or 
minimum shutter speed to one that is not a full-stop increment (such as 1/3200 sec.).
To ensure that a proper flash sync speed is set in the Program AE mode, a shutter 
speed range of 1/200 sec. to 1/80 sec. cannot be set with the EOS-1D Mark II N, 
EOS-1Ds Mark II, EOS-1D Mark II and EOS-1Ds, and the range of 1/400 sec. to 1/80 
sec. cannot be set with the EOS-1D.
If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter speed 
range.

Specify a minimum aperture value that is smaller than the maximum aperture setting. 
If you select a minimum aperture value that is larger than the maximum aperture, a 
warning message appears and the setting reverts to the default value.
If you set the maximum and/or minimum aperture to one that is not a full-stop 
increment (such as f/4.5), the controllable and settable aperture range might not be 
as exact as you set it (A slight deviation may occur.). This applies if you also set 
Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum 
aperture to one that is not a full-stop increment (such as f/6.3).
If the largest aperture of the attached lens is smaller than the largest aperture you set 
with P.Fn-05, the largest aperture will be set to the lens’ largest aperture. And if the 
largest aperture of the attached lens is smaller than the smallest aperture you set with 
P.Fn-05, the aperture will be set and fixed to the lens’ largest aperture.
If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05’s aperture 
range.

P.Fn-04

P.Fn-05
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Registers and switches the shooting mode and metering mode
Only while you press the <  > button, you can switch to the preset shooting mode, 
exposure setting (such as the aperture for aperture-priority AE), metering mode, and 
exposure compensation amount.
Select settings that are appropriate for each shooting mode.
The modes and settings are preset with the camera.
See “Registering the Modes and Settings with the Camera” (see the right description) for 
information on the camera procedures.
Convenient when you want to instantly select the preset modes and settings to suit a 
particular shooting situation such as backlit or front-lit conditions.

Repeats bracketing during continuous shooting
While you hold down the shutter button, bracketing repeats continuously in the currently 
selected drive mode.
This function is useful when you want to continuously repeat the bracketing sequence.

Sets the number of shots to be bracketed
Select the number of shots from the list box.
The usual 3-frame bracketing is changed to 2-, 3-, 5-, or 7-frame bracketing.
In bracketing shots, if you select 5-frame bracketing with 1-stop increment, the bracketing 
for the shots is –2, –1, 0, +1 and +2.
This function is useful for adjusting the range of bracketing.

Changes the bracketing sequence for C.Fn-09-2/3 to increased 
exposure, standard exposure, and decreased exposure

The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure  standard 
exposure  increased exposure) changes to increased exposure  standard exposure  
decreased exposure.
This function is useful when you want to start the bracketing sequence with a increased 
exposure.

Even when the setting is outside the bracketing level display range, the exposure is 
compensated as specified.
This function can be used in combination with C.Fn-09-2/3 and P.Fn-09.

This function can be used in combination with P.Fn-08.

P.Fn-06

P.Fn-07

P.Fn-08

P.Fn-09

Registering the Modes and Settings with the Camera ( )

1 Set the shooting mode and shooting mode settings (for 
example, aperture setting for aperture-priority AE mode). Then 
set the metering mode and exposure compensation amount.

2 Register the modes and settings.
First press the <  > button, then press 
the <  > button.

<  >appears in the LCD panel, 
indicating that the modes and settings 
have registered.
The registered modes and settings can 
be modified any number of times.

To register the modes and settings, first press the <  > button before the <  > 
button. If you press the <  > button first, the camera will only select the 
registered modes and settings instead.
Bulb cannot be preset.
You cannot select the registered modes and settings during continuous shooting.

If P.Fn-03 has been set to specify the metering mode for manual exposure, and 
P.Fn-06 is used to register the manual exposure mode and a metering mode 
different from the one specified with P.Fn-03, you can select the metering mode 
specified with P.Fn-03 by pressing the <  > button.
If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture within 
the range specified with P.Fn-04 and/or P.Fn-05.
If the shooting and metering modes you want to set are excluded by the 
restrictions in P.Fn-01 and P.Fn-02, those Personal Functions must be disabled. 
For information on clearing and resetting Personal Functions, refer to “Clearing 
and Resetting Personal Functions” in the camera’s Instruction Manual.
Even if the shooting and metering modes selected by P.Fn-06 are excluded by the 
restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when you 
press the <  > button.
When C.Fn-18 is set, P.Fn-06 is disabled.

P.Fn-06
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Retains the shift amount for program shift
Normally, any program shift amount is canceled after you take the picture. This Personal 
Function retains the program shift amount.
This function is useful when you want to shift the standard program line so that priority is 
given to the shutter speed or to the aperture.

By shifting the program, you can change the shutter speed or aperture and still retain the same 
exposure level. Under the same brightness, you can shift the program line toward the right to 
set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the program 
line toward the left to set a slower shutter speed and a smaller aperture (higher f/number).
P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the level 
of priority you want to give to the shutter speed or aperture setting.

Executes AI Servo AF continuous shooting giving priority to 
the drive speed

During continuous shooting, shutter release-priority takes effect instead of focus-priority.
Effective when it is more important to capture an image even though it might be slightly out 
of focus.
This function is compatible with the EOS-1D only.

The program shift amount remains in effect until you set it back to the standard program 
manually or replace the battery or press the <CLEAR> button.
The shift amount is retained even after you change the lens.

P.Fn-10
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P.Fn-13

Disables focus detection (search driving) by the lens drive
Normally, when you press the shutter button halfway and focus cannot be achieved, the lens 
is driven to search the correct focus. This lens driving operation can be turned off.
When focus has been achieved once and refocusing fails, the subsequent lens driving 
operation can result in grossly out of focus. This subsequent lens driving operation is turned 
off. P.Fn-14 is especially suited for super telephoto lenses.

Disables the AF-assist beam from being emitted
This disables the external Speedlite’s built-in AF-assist beam.
At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the 
subject from being photographed by other photographers.

Enables automatic shooting when focus is achieved at the 
fixed point of focus while the shutter button is pressed fully

This takes the picture automatically when the subject comes to the preset focusing distance. 
Focusing detection is performed using the selected AF point.
Set the lens focus mode switch to <MF> and focus manually at the desired point of focus.
Keep pressing the shutter button fully.
Using an accessory such as Remote Controller RS-80N3 which can lock the shutter button 
relieves you from holding down the shutter button while you wait for the subject.

If autofocusing is attempted while the lens is way out of focus, the lens may stop 
operating. Focus manually until the subject outline becomes discernable, then 
autofocus.

Because the camera remains on standby while the shutter button is fully pressed, 
battery power is used up more quickly. For long periods of photography, use the DC 
Coupler Kit.
When this function is used in combination with a flash, the flash remains on standby 
at full charge. Consequently, the flash batteries are used up more quickly. (The 
Speedlite’s SE mode is disabled.)
When you use a flash with this function, set the drive mode to single-frame shooting. 
If you select continuous shooting, the flash will be unable to charge in time for 
successive shots and will not fire at full charge.
If you set the drive mode to continuous shooting, set the number of shots in P.Fn-20. 
If you do not use P.Fn-20, once the camera focuses on the subject, continuous 
shooting will continue until the capacity of the memory card is reached.
P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow to 
be used with autofocusing.
Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of 
whether the image is in focus.

Using an accessory such as Remote Controller RS-80N3 which can lock the shutter 
button is recommended.

P.Fn-14

P.Fn-15

P.Fn-16
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Disables automatic AF point selection
When you select beyond the peripheral AF point, the selection stops there. It makes 
selecting a peripheral AF point faster.

Enables automatic AF point selection when C.Fn-11-2 has 
been set

Enables the standard horizonal AF point selection together with automatic AF point 
selection with C.Fn-11-2.
Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been 
set.

Sets the continuous shooting speed
In the list box, select the speed of continuous shots during continuous shooting.
By reducing the maximum continuous shooting speed, AI Servo AF continuous shooting can 
be more stable.
With the EOS-1Ds Mark II and EOS-1Ds, only [Continuous Shooting] is displayed.

Limits the number of shots during continuous shooting
This enables you to enter the maximum number of shots to be exposed during continuous 
shooting while the shutter button is pressed fully.
Convenient when you do not want to shoot an unwanted scene that follows.

If C.Fn-11-2 has been set, you can switch to automatic AF point selection by pressing 
the <  > button during autofocusing. (  “Selecting the AF Point” in the camera’s 
Instruction Manual)
If automatic AF point selection has been preset at [AF frame registration] setting, the 
preset setting remains valid. (  “Registering and Switching the AF Point” in the 
camera’s Instruction Manual)

If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will 
override P.Fn-18 to disable automatic AF point selection.

In AI Servo AF, it may not be possible to complete the selected speed of continuous 
shots.

P.Fn-17

P.Fn-18

P.Fn-19

P.Fn-20

Enables quiet operation when the shutter button is OFF after 
picture-taking

When single shooting is selected, this function selects quiet camera operation when you 
release the shutter button from the fully pressed position to the half way position.
This is useful when the camera operation noise would be disturbing after you take the 
picture.

Changes the timer’s time length
After you press and release a button, the respective function remains active for a specific 
number of seconds. You can change this number of seconds as necessary.
The function’s activation time can be set from 0 to 3600 sec. (1 hour).
If the standard activation time is too short or too long, you can adjust it.

Illuminates the LCD panel during bulb exposures
After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the 
LCD panel until the bulb exposure ends.
Convenient when you want to monitor the elapsed bulb exposure time.

If you select continuous shooting, the camera operates normally.

Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

6 sec. Timer AE lock time after you press the shutter button halfway or the <  > 
button.

16 sec. Timer FE lock time after you press the <  > button.

Post-shutter
release timer

Exposure setting retaining time after the picture is taken. Setting 
this to a longer time can make it easier to shoot in the same 
exposure with AE lock.
LCD panel illumination time after the picture is taken.

Note that if you set a longer activation time, the battery become exhausted more quickly 
and the number of possible shots will be reduced.

To turn off the function’s activation time midway, press the <  > button, <  > 
button or <  > button.

Note that if you take bulb shots for long periods, the battery becomes exhausted more 
quickly and the number of possible shots will be reduced.

P.Fn-21

P.Fn-23

P.Fn-24
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Sets the default settings when the <CLEAR> button is ON
You can use this function to select the default mode settings when you press the <CLEAR> 
button.
Convenient when you want to instantly switch to frequently-used settings.

Shortened release time lag
Normally, the shutter-release time lag is controlled for stability. This Personal Function 
eliminates this control. As a result, the shutter-release time lag can be reduced by as much 
as about 20 percent when the aperture needs to be stopped down by no more than 3 stops.
This is effective when a shorter shutter-release time lag is more important than a stable 
shutter-release time lag.
This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II and EOS-1D 
Mark II.

Enables the electronic dial’s function to be used in the reverse 
direction

The electronic dial’s rotational function can be reversed for selecting the AF point and 
setting the shutter speed and aperture.
By matching the dial’s rotation direction to the particular operation, the operation can feel 
more intuitive.

Prevents exposure compensation with the Quick Control Dial
The Quick Control Dial cannot be used to set exposure compensation.
This prevents exposure compensation from being set accidentally while the AF point is 
being selected.

Since the difference is in 10-millisecond increments, the time lag may not feel any 
shorter.

When the main dial’s rotational function is reversed, the horizontal AF point selection 
direction does not change.

P.Fn-25

P.Fn-26

P.Fn-27

P.Fn-28

Enables Quick Control Dial switch to turn on/off Main Dial, too
Setting the Quick Control Dial switch to <OFF> disables the Main and Quick Control Dials.
This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II and EOS-1D 
Mark II.

Enlargement mode
Select which part of an image is enlarged.
If you take the shot on the camera with this function [ON], you can enlarge an image.
For more imformation on using this function on the camera, see “P.Fn-30 Enlarging the 
image” in the EOS-1Ds Instruction Manual.
This function is compatible with the EOS-1Ds only.

Add original decision data
The data that shows whether or not the image is the original one can be added to the image.
When selecting the display format of Shooting information (INFO), the icon showing the 
captured image with Original image verification data is displayed.
For more details, refer to “Shooting Information Display” in the camera’s Instruction Manual.
For the decision of the original image, you will need the dedicated accessory (optional).
This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark 
II and EOS-1Ds.

If you wish to enlarge an image, set P.Fn-30 to [ON] during shooting and playback. 
The image shot on the camera without setting P.Fn-30 to [ON] cannot be enlarged.
The image shot on any camera other than the EOS-1Ds cannot be enlarged.

The original decision data cannot be added to the JPEG or TIFF image converted from 
the RAW image.

P.Fn-30

P.Fn-30

P.Fn-31
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You can check the specified Personal Functions and the status of whether or not the settings 
are applied to the camera. You can also save the settings on your computer and then load the 
saved settings and apply them to the camera.

1 Specify the Personal Functions (p.4-3 to p.4-8).

2 Select [Combination] from the list box.
The [Combination] window appears.
With the EOS-1Ds and EOS-1D, select the 
[Combination] tab.

3 Check the settings, save and load them.
You can check the Personal Function settings and check if these settings are applied 
on the camera.

Checking, Saving, and Loading Personal Function Settings
Saving the Settings

Loading the Settings

1 Click the [Save as] button.
The [Save As] dialog box appears. 

2 Select the destination folder, enter the file name, and then click 
the [Save] button.

The specified Personal Function settings are saved.

The Personal Function settings are not compatible with a camera other than the one the 
function was set.

To update an existing file, click the [Save] button.
Personal Function settings data saved in your computer is compatible with both 
Windows and Macintosh.

1 Click the [Open] button.
The [Open] dialog box appears.

2 Open the folder containing the settings, select the file, and then 
click the [Open] button.

The Personal Function settings data saved in that file are loaded.
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Shot Settings
You can specify various shot settings and then apply these settings to the camera.

1 Display the [Camera settings] dialog box (p.4-2).

2 Select the [Shoot settings] tab.
The [Shoot settings] tab sheet appears.
With the EOS-1Ds and EOS-1D, select the 
[Detailed Settings] tab.

3 Click one of the buttons to display each dialog box and specify 
desired settings (p.4-11 to p.4-15).

4 Click the [OK] button.
The settings are applied to the camera and the [Camera settings] dialog box closes.

Loads the saved tone curves, and allows you to 
select color channels and register them on the 
camera (p.4-13).Loads the personal white balance settings, 

and then registers them on the camera 
(p.4-14). Allows you to select color matrix settings and then 

register them on the camera (p.4-15).

Allows you to specify JPEG quality settings 
(L, M1, M2, S), and register them on the 
camera (p.4-15). 

Applies the settings to the camera and closes the 
dialog box.

Applies the settings to the camera.

Cancels all the settings and closes the dialog box.

Allows you to select tone curves, specify the 
sharpness and contrast, and then register them on 
the camera (p.4-12).

With the EOS-1Ds and EOS-1D, the [Tone curve], [Color matrix] and [JPEG quality] 
buttons are not displayed.

Applies the settings to the camera.
* With the EOS-1Ds and EOS-1D, the [Apply] button is displayed.

Cancels all the settings and closes the dialog box.

Applies the settings to the camera and closes the 
dialog box.

With the EOS 5D, the [Personal white balance] and [JPEG quality] buttons are not 
displayed.

Allows you to specify a Picture Style and register it 
on the camera (p.4-11).

EOS-1D Mark II N and EOS 5D window
EOS-1Ds Mark II, EOS-1D Mark II, 
EOS-1Ds and EOS-1D window
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You can set a Picture Style as well as register in your camera a Picture Style downloaded from 
Canon’s web site and saved on your computer, as a user setting.

This function is compatible with the EOS-1D Mark II N and EOS 5D.

Picture Style

Select the Picture Style to be set.

If you have selected [User Def. 1] to [User Def. 
3] in the [Picture Style] list box, you can click the 
[Open] button and load a Picture Style file 
saved on your computer. You can also select 
from the list box the Picture Style that will 
become the base.

Deletes the selected Picture Style from the camera.

Drag the slider for each item left or right to set.

Cancels all the settings and closes the dialog box.

Applies the settings to the camera.

1 Click [Picture style] button (p.4-10).
The [Picture Style setting] dialog box 
appears.

2 Specify desired settings.

3 Click [Apply] button.
The [Confirm settings] dialog box appears.

4 Confirm the settings and click [OK] button.
The settings are applied to the camera.

5 Click [Close] button.
The [Picture Style setting] dialog box closes.

You can register a maximum of 3 user settings in your camera.
When you select [Monochrome] in the [Picture Style] and [User Base Picture Style] list 
boxes, the [Filter Effect] and [Toning Effect] list boxes appear.
Refer to “Registering the Picture Style” in the camera’s Instruction Manual for information 
about using the Picture Styles registered in the camera.

A Picture Style file is a file that expands the Picture Style function. For detailed 
information on Picture Style, refer to Canon’s web site.
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You can select tone curves, specify the sharpness and contrast, and then register up to 3 sets 
of these settings on the camera.

For more information on setting the processing parameters on the camera, refer to “Setting 
the Processing Parameters” in the camera’s Instruction Manual.
This function is compatible with the EOS-1Ds Mark II, EOS-1D Mark II, EOS-1Ds and 
EOS-1D.

1 Click the [Parameters] button (p.4-10).
The [Parameters settings] dialog box 
appears.
With the EOS-1Ds and EOS-1D, click the 
[Add Set] button and in the dialog box that 
appears, select the set which will be 
added to the camera.

2 Select the [Set 1], [Set 2], or [Set 3] tab.

3 Specify desired settings.
With the EOS-1Ds Mark II and EOS-1D Mark II, the following dialog box appears.

Specifying the Parameters

Drag the slider left or right to specify the sharpness and contrast.

Applies the settings to the camera.

[Standard]:
The standard tone curve is set.
[TCD 1] through [TCD 3]:
The tone curve that has been loaded in 
“Specifying the Tone Curve” (p.4-13) is set.

Closes the dialog box.

With the EOS-1Ds and EOS-1D, the following dialog box appears.

4 Click the [Apply to camera] button.
The [Confirm settings] dialog box appears.

5 Confirm the settings and click the [Yes] or [Apply to Camera] button.
The parameter is registered on the camera.

6 Click the [Close] button.
The [Parameters settings] dialog box closes.

[Standard]:
The standard tone curve is set.
[TCD1] through [TCD3] (EOS-1Ds), 
[User Defined] (EOS-1D):
The tone curve that has been loaded in 
“Specifying the Tone Curve” (p.4-13) is set.

Select the items to be set from each list box.

The tone curve to be registered in [TCD1] through 
[TCD3] or [User Defined] is set (p.4-13).

Adds a new set.*

Deletes a selected set.*

* Displayed when connected to the EOS-1D.

Displays the Help dialog box.

Closes the dialog box.
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You can load saved tone curve files from a computer (p.2-13) and register up to 3 on the 
camera. You can also select the tone curve that has been loaded into the [TCD 1] through [TCD 
3] tab sheets, from the list box shown in “Specifying the Parameters” (p.4-12).

For more information on registering the tone curve ([TCD 1] through [TCD 3]) on the 
camera, refer to “Setting the Processing Parameters” in the camera’s Instruction Manual.
This function is compatible with the EOS-1Ds Mark II, EOS-1D Mark II, EOS-1Ds and 
EOS-1D.
With the EOS-1D, only one tone curve can be registered.

1 Click the [Tone curve] button (p.4-10).
The [Tone curve settings] dialog box 
appears.
With the EOS-1Ds and EOS-1D, click the 
[Parameters] button and then click the 
[User-Defined Tone Curve] button on the 
displayed [Parameters Settings] dialog 
box.

2 Select the [TCD 1], [TCD 2] or [TCD 3] tab.
For the EOS-1D, proceed to step 3.

3 Click the [Open] button.
The [Open] dialog box appears.

4 Open the folder containing the tone curve, select a file, and then 
click the [Open] button

The tone curve is loaded.

Specifying the Tone Curve 5 Select a channel from the list and confirm.

6 Click the [Apply to camera] button.
The tone curve is registered on the camera.

7 Click the [Close] button.
The [Tone curve settings] dialog box closes.

Closes the dialog box.

Applies the settings to the camera.
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You can load saved white balance file from a computer (p.2-13) and register up to 3 on the 
camera.

When you upload a personal white balance setting to the camera, <  > to <  > 
is displayed on the rear LCD panel of the camera.
For more information on setting the personal white balance on the camera, refer to 
“Selecting the White Balance” in the camera’s Instruction Manual.
This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark 
II, EOS-1Ds and EOS-1D.

1 Click the [Personal white balance] button (p.4-10).
The [Personal white balance settings] 
dialog box appears.

2 Select the Personal white balance (PC) to be registered from the 
list.

Specifying the Personal White Balance 3 Click the [Open] or [Browse] button.
The [Open] dialog box appears.

4 Open the folder containing the saved white balance, select the 
file, and then click the [Open] button.

The white balance is loaded.

5 Enter a title in the [Title] or [Caption] input box.

6 Click the [Apply to camera] button.
The white balance is registered on the camera.
To register another setting, repeat steps 2 to 6. You can register up to 3 settings (PC-
1, PC-2 and PC-3).
To delete a registered setting, select the Personal white balance (PC) from the list 
and click the [Delete from camera] button.

7 Click the [Close] button.
The [Personal white balance settings] dialog box closes.

Displays the setting status for the 
Personal white balance (PC) 
registered on the camera along 
with their titles.

Registers the selected Personal white balance (PC) settings on the camera.

Deletes the selected Personal white balance (PC) from the camera.

Enter a title for the personal white balance to be registered.

Closes the dialog box.
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You can specify the color space, color saturation, and color tone, and then register up to 2 sets 
of these settings on the camera. You can also select the predetermined color matrix from the 
list box, which helps you to specify the settings.

For more information on setting the color matrix on the camera, refer to “Selecting the Color 
Matrix” in the camera’s Instruction Manual.
This function is compatible with the EOS-1Ds Mark II and EOS-1D Mark II.

1 Click the [Color matrix] button (p.4-10).
The [Color Matrix settings] dialog box 
appears.

2 Select [CM set1] or [CM set2] from the list box.
This activates the [Color space], [Color 
saturation], and [Color tone] list boxes.
If you select any color matrix setting other 
than [CM set1] or [CM set2], you cannot 
register the settings on the camera.

3 Select desired settings from the list boxes.

4 Click the [Apply to camera] button.
The color matrix is registered on the camera.

5 Click the [Close] button.
The [Color Matrix settings] dialog box closes.

Specifying the Color Matrix

Applies the settings to the camera.

Closes the dialog box.

You can specify the JPEG quality for each of the sizes, L (Large), M1 (Middle 1), M2 (Middle 2), 
and S (Small), and then register the settings on the camera.

This function is compatible with the EOS-1D Mark II N, EOS-1Ds Mark II and EOS-1D 
Mark II.

1 Click the [JPEG quality] button (p.4-10).
The [JPEG quality settings] dialog box 
appears.

2 Drag the slider left or right to adjust the JPEG quality.
Higher values give a lower compression 
ratio and higher image quality for any size.

3 Click the [Apply to camera] button.
The JPEG quality is registered on the camera.

4 Click the [Close] button.
The [JPEG quality settings] dialog box closes.

Specifying the JPEG Quality

Applies the settings to the camera.

Closes the dialog box.
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Troubleshooting and Uninstalling the Software

This chapter provides troubleshooting and explains how to uninstall the 
software.

Click on the item to display its page.
Uninstalling the Software ..................................................................................5-3

Uninstalling the Software .................................................................................5-3

Uninstalling the Driver......................................................................................5-3

Index ....................................................................................................................5-4

Troubleshooting
If you could not complete the installation correctly, or communication between the camera and 
computer fails, or you connected the camera and computer before installing the software, 
consult the items described below.

For instructions on installing, refer to the “Software Guide” supplied with your camera.

If you are using Windows XP Professional or Windows 2000, are you using 
the computer under a user setting other than [Computer administrator] or 
[Administrator]?

You cannot install software if a user setting other than [Computer administrator] or 
[Administrator] is selected. Select the [Computer administrator] user setting in Windows 
XP Professional or the [Administrator] user setting in Windows 2000. For detailed 
information on selecting the user setting, refer to the computer User’s Manual.

Is the cable firmly plugged into its socket?
To complete the installation, ensure that the plugs on the dedicated cable are securely 
plugged into the ports on the camera and computer when you connect the camera to 
your computer.

Are the camera and computer set up correctly for communication?
Is the camera’s power switch set to <ON>?
Even when the camera’s power switch is set to <ON>, operation of the Auto power off 
function will automatically switch the camera off. To prevent this, set the Auto power off 
function to [Off]. (Refer to the camera’s Instruction Manual.)

Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in 
Windows 2000) dialog box appear during installation?

Click the [Cancel] button, disconnect the dedicated cable, and then repeat the 
installation procedure from the beginning. 

Doesn’t the installer panel appear?
Use the following procedure to display the installer panel.
Click the [Start] button  [My Computer]. (In versions other than Windows 
XP, double-click [My Computer] on the desktop.)  right-click the CD-
ROM drive containing the CD  select [Open] from the menu that appears 

 double-click the icon on the right.

Installation failed.
Is the driver installed?

The driver is required for communication between the camera and computer. When you 
want to communicate between the camera and computer, be sure to install the driver 
shown below appropriate to your windows.
• Windows XP/Windows Me: WIA Driver
• Windows 2000/Windows 98SE: TWAIN Driver

Have you installed the WIA Driver or TWAIN Driver?
Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed 
unless the camera is connected to the computer. Insert the Solution Disk into the CD-
ROM drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your 
computer.

Does your computer comply with these requirements?
Cameras other than EOS-1D series cameras

Computer with Windows XP, Windows 2000, Windows Me or Windows 98SE 
preinstalled and equipped with a USB port.
* Operation is not guaranteed when a connection is used on computer systems other 

than those listed above.
EOS-1D series cameras

Computer with Windows XP, Windows 2000, Windows Me, or Windows 98SE 
preinstalled and equipped with an IEEE1394 port.
* Operation is not guaranteed when a connection is used on computer systems other 

than those listed above.

Are the camera and computer connected correctly?
Connect the camera to your computer correctly using the dedicated cable (p.1-2).

Have you made the correct communication settings for cameras that 
require communication settings?

Set the camera’s communication mode to [PC connect.] or [PC connection] for the EOS 
5D and EOS 350D DIGITAL, and to [Normal] for the EOS 20D, EOS 300D DIGITAL and 
EOS 10D (p.1-1). 
With the EOS 10D, you must also change the firmware to version 2.0.0 or later. For 
details on changing, refer to the Canon web site.

I have installed the software but the camera and 
computer cannot communicate.
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Is there sufficient charge left in the camera battery?
Your computer does not supply power to the camera. Connect the AC Adapter Kit 
(optional) for the EOS 5D, EOS 350D DIGITAL, EOS 20D, EOS 300D DIGITAL and EOS 
10D, the DC Coupler supplied with the camera for the EOS D60 and EOS D30, and the 
DC Coupler Kit supplied with the camera for the EOS-1D series cameras. Alternatively, 
insert a charged battery and connect your computer and camera.

Do you have more than one camera connected to your computer?
If you connect more than one camera to the same computer, the driver and camera may not 
operate normally.

Exit the software and disconnect all the dedicated cables. Then connect only one 
camera to the same computer again.

Is the driver operating normally?
Connect the camera to your computer 
with the dedicated cable and set the 
camera’s power switch to <ON> and 
open [Device Manager]. 
Click the plus symbol [+] to the left of 
[Imaging devices] and check that the 
connected camera is displayed.

If the connected camera is not 
displayed, the driver is not operating 
normally. 
Briefly disconnect and then reconnect the dedicated cable, ensuring that the connection 
is secure. If the connected camera still does not appear, use the following procedure to 
re-install the driver.
1 Disconnect the dedicated cable and delete the driver (p.5-3).
2 Re-install the driver.
When the [X], [!] or [?] symbol is displayed beside the connected camera, part of the 
driver is missing or corrupted. Use the following procedure to re-install the driver.
1 Delete the camera displayed in [Imaging devices].
2 Disconnect the dedicated cable and delete the driver (p.5-3).
3 Re-install the driver.

Is the driver installed correctly?
Connect the camera to your computer with the dedicated cable and set the camera’s 
power switch to <ON> and open [Device Manager]. Click the plus symbol [+] to the left of 
[Other devices] or [Unknown devices] and check whether the connected camera or 
[Canon Digital Camera] is displayed.

If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or 
[Unknown devices], the driver was not installed correctly. Use the following procedure to 
re-install the driver.
1 Delete the camera or [Canon Digital Camera] displayed in [Other devices] or 

[Unknown devices].
2 Disconnect the dedicated cable and delete the driver (p.5-3).
3 Re-install the driver.

Did you set the camera’s power switch to <ON>?
If you did not set the camera’s power switch to <ON>, proceed as follows:
1 Disconnect the dedicated cable from the camera and computer.
2 Install the Solution Disk software on your computer using the correct installation 

procedure and then connect the camera to your computer to complete the installation.
If you set the camera’s power switch to <ON>, proceed as follows:
1 If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel] 

buttons to cancel all the dialog boxes.
2 Set the camera’s power switch to <OFF>.
3 Disconnect the dedicated cable from the camera and computer.
4 Install the Solution Disk software on your computer using the correct installation 

procedure and then connect the camera to your computer to complete the installation.

I connected the camera to the computer before 
installing the software

To Display the Device Manager
Windows XP

Click the [Start] button  select [Control Panel]  [Performance and Maintenance]
  [See basic information about your computer]. Then select the [Hardware] tab 
and click the [Device Manager] button.

Windows 2000
Click the [Start] button  select [Settings]  [Control Panel]. Then double-click the 
[System] icon to open and select the [Hardware] tab and click the 
[Device Manager] button.

Windows Me and Windows 98SE
Click the [Start] button  select [Settings]  [Control Panel]. Then double-click the 
[System] icon to open and select the [Device Manager] tab.
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Uninstalling the Software
Before beginning the uninstallation, exit all programs you are using and disconnect the 
dedicated cable from your computer.

The following explanation uses the procedures for uninstalling the ZoomBrowser EX as an 
example for uninstalling other programs as well.

For Windows XP Professional or Windows 2000, log in using computer Administrator 
privileges.
Before beginning the uninstallation, exit all programs you are using and disconnect the 
dedicated cable from your computer.
To prevent computer malfunctions, always restart your computer after you have uninstalled 
the software. Re-installing the software without first restarting your computer is likely to 
result in computer malfunctions.

1 Click the [Start] button  select [All Programs] ([Programs] in 
versions other than Windows XP)  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX Uninstall].

2 Proceed with the uninstallation as directed by the on-screen 
messages.

Software is uninstalled.

Uninstalling the Software This section explains how to uninstall the EOS-1D Mark II N and EOS 5D driver. The EOS 
350D DIGITAL, EOS-1Ds Mark II and EOS 20D drivers can be deleted with the same 
operation. Refer to the software Instruction Manual supplied with the camera about deleting 
drivers in cameras other than those mentioned above.

For Windows XP Professional or Windows 2000, log in using computer Administrator 
privileges.
Before beginning the uninstallation, exit all programs you are using and disconnect the 
dedicated cable from your computer.

1 Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].
Your camera model is displayed in EOS XXX.
For Windows XP or Windows Me, click the [Start] button  select [All Programs] 
([Programs] in Windows Me)  [Canon Utilities]  [EOS XXX WIA Driver]  [WIA 
Driver Uninstall].
For Windows 2000 or Windows 98SE, click the [Start] button  select [Programs]  
[Canon Utilities]  [EOS XXX TWAIN Driver]  [TWAIN Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen 
messages.

The driver is uninstalled.

3 Restart the computer.
When the dialog box on the right 
appears, select the [Yes, I want to 
restart my computer now.] and 
click [Finish] button.
When the computer is restarted, 
uninstalling of the driver is 
completed.

Uninstalling the Driver
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